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WARRANTY

Tektronix warrants that the products that it manufactures and sells will be free from defects in materials and
workmanship for a period of one (1) year from the date of shipment. If a product proves defective during this
warranty period, Tektronix, at its option, either will repair the defective product without charge for parts and labor,
or will provide a replacement in exchange for the defective product.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration
of the warranty period and make suitable arrangements for the performance of service. Customer shall be
responsible for packaging and shipping the defective product to the service center designated by Tektronix, with
shipping charges prepaid. Tektronix shall pay for the return of the product to Customer if the shipment is to a
location within the country in which the Tektronix service center is located. Customer shall be responsible for
paying all shipping charges, duties, taxes, and any other charges for products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use or improper or inadequate
maintenance and care. Tektronix shall not be obligated to furnish service under this warranty a) to repair damage
resulting from attempts by personnel other than Tektronix representatives to install, repair or service the product;
b) to repair damage resulting from improper use or connection to incompatible equipment; c) to repair any
damage or malfunction caused by the use of non-Tektronix supplies; or d) to service a product that has been
modified or integrated with other products when the effect of such modification or integration increases the time
or difficulty of servicing the product.

THIS WARRANTY IS GIVEN BY TEKTRONIX IN LIEU OF ANY OTHER WARRANTIES, EXPRESS
OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX’
RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE SOLE AND
EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH OF THIS WARRANTY.
TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX OR
THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
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General Safety Summary

Review the following safety precautions to avoid injury and prevent damage to
this product or any products connected to it. To avoid potential hazards, use this
product only as specified.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of the system. Read
the General Safety Summary in other system manuals for warnings and cautions
related to operating the system.

To Avoid Fire or  Use Proper Power Cord. Use only the power cord specified for this product and
Personal Injury  certified for the country of use.

Connect and Disconnect Properly. Do not connect or disconnect probes or test
leads while they are connected to a voltage source.

Ground the Product. This product is grounded through the grounding conductor
of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings
and markings on the product. Consult the product manual for further ratings
information before making connections to the product.

Do Not Operate Without Covers. Do not operate this product with metal covers or
panels removed.

Avoid Exposed Circuitry. Do not touch exposed connections and components
when power is present.

Do Not Operate With Suspected Failures. If you suspect there is damage to this
product, have it inspected by qualified service personnel.

Do Not Operate in Wet/Damp Conditions.
Do Not Operate in an Explosive Atmosphere.
Keep Product Surfaces Clean and Dry.

Provide Proper Ventilation. Refer to the manual’s installation instructions for
details on installing the product so it has proper ventilation.

VMS5000 Option HD Automatic Video Measurement Set User Manual vii
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Symbols and Terms

VAN

Terms in this Manual. These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result
in injury or loss of life.

/N

CAUTION. Caution statements identify conditions or practices that could result in
damage to this product or other property.

Terms on the Product. These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the
marking.

WARNING indicates an injury hazard not immediately accessible as you read the
marking.

CAUTION indicates a hazard to property including the product.
Symbols on the Product. The following symbols may appear on the product:

AN A O

CAUTION WARNING Protective Ground
Refer to Manual High Voltage (Earth) Terminal

VM5000 Option HD Automatic Video Measurement Set User Manual
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Preface

This is the user manual for the VM5000 Option HD Automatic Video Measure-
ment Set. This manual focuses on the automatic video measurement functional-
ity; it does not cover the oscilloscope functionality. Refer to Related Manuals
and Online Documents for where to find information about using the oscillo-
scope functionality.

About This Manual

This manual is composed of the following chapters:

B Getting Started shows you how to configure and install your instrument and
provides a functional check procedure.

®  Operating Basics, using a highly-graphical approach, walks you through the
basics of using the instrument user interface.

B Reference goes into more detail on the menu functions, understanding the
measurements, and interpreting your results.

B Appendices provides additional information including instrument specifica-
tions, performance verification, remote command information, cleaning
information, and signal source descriptions.

VMS5000 Option HD Automatic Video Measurement Set User Manual ix
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Related Manuals and Online Documents

This manual is part of a document set of manuals and online documentation. See
the following list for other documents supporting operation and service.

Manual name

Description

VM5000HD Automatic Video Measurement
Set Online Help

An integrated online help system, which can be accessed from the VM5000 Option HD
help menu (located in the middle of the screen when the VM5000 Option HD
application is open).

TDS5000B Series Digital Phosphor Oscillo-
scopes Quick Start User Manual

A paper manual, which ships with the instrument, has information about installing and
operating your instrument.

TDS5000B Series Digital Phosphor Oscillo-
scopes Online Help

An integrated online help system, which can be accessed from the oscilloscope
platform help menu (located at the top right of the screen).

Specifications and Performance Verification

A .pdf only manual that includes both instrument specifications and the instrument
performance verification procedure. You can access this manual from the instrument
help menu, and it is installable from the TDS50008 Series Product Software CD.

TDS5000B Series Oscilloscope Online
Programmer Guide

Online help and .pdf versions are available from the TDS5000B Series Product
Software CD.

TDS5000B Series Digital Phosphor Oscillo-
scopes Service Manual

A description of how to service the instrument to the module level. This optional
manual must be ordered separately.

VMS5000 Option HD Automatic Video Measurement Set User Manual
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Contacting Tektronix

Phone 1-800-833-9200%

Address Tektronix, Inc.
Department or name (if known)
14200 SW Karl Braun Drive

P.O. Box 500

Beaverton, OR 97077

USA
Web site www.tektronix.com
Sales support 1-800-833-9200, select option 1*
Service support 1-800-833-9200, select option 2*

Technical support Email: techsupport@tektronix.com
1-800-833-9200, select option 3*
6:00 a.m. - 5:00 p.m. Pacific time

*  This phone number is toll free in North America. After office hours, please leave a
voice mail message.
Outside North America, contact a Tektronix sales office or distributor; see the
Tektronix Web site for a list of offices.

VMS5000 Option HD Automatic Video Measurement Set User Manual
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Product Description

This manual supports the VM5000 Option HD Automatic Video Measurement
Set.

This chapter summarizes and highlights some of the key features of the
instrument. Following this description are three sections:

B [nstallation shows you how to configure and install the instrument, as well
as how to reinstall the system software included with the product.

B [ncoming Inspection procedure verifies basic operation and functionality.

B Accessories lists the standard and optional accessories for this product.

Key Features

The VM5000 Option HD instrument is a high-performance solution for
verification, debugging, and characterization of analog high-definition video
signals. Key features include:

®  Fast, accurate, and repeatable video measurements
®  Fully automated, comprehensive component analog video measurements

®  Supports HDTV, progressive, and PC-format component analog video
(YPbPr and RGB)

B Acquisition bandwidth & high sample rates for HDTV signals

®m  Signal Source Disks for convenient test signal generator setup (see page F-1)
®  Powerful automated measurement features and utilities

®m  Standard GPIB remote control capability

®  MS Windows operating system, an intuitive graphical user interface, and
online help for easy operation with minimal training time

B Video measurement accessories
®  Extended documentation capabilities
®  Complete oscilloscope functionality

Targeted to meet the needs of video professionals developing, testing, and
manufacturing the next generation of Digital Television reception and play-out
devices, the instrument incorporates the power, features, and functionality
needed in R&D, QA, and Production Test applications. It enables manufacturers

VMS5000 Option HD Automatic Video Measurement Set User Manual 1-1
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to ensure that HDTV video signal quality is up to the challenge of today’s high
performance displays, as well as enables clear differentiation between input
signal and display device impairments.

Applications include the following:

® R&D

®  Compliance & certification testing
®  Quality/audit testing

B Automated production test

®m  Off-air video systems testing

The VM5000 Option HD automates a variety of component analog video
measurements utilized to verify the integrity and quality of HDTV video signals.
It automatically assesses conformance of selected video signal parameters to
applicable EIA-770-3, SMPTE - 274M, and 296M standards. It also automates
measurement of other industry-standard video parameters that are utilized to
quantify the performance of Digital Set-top boxes or other Consumer video
reception and play-out devices with component analog interfaces.

By integrating automated measurement algorithms and a high-speed, wide
bandwidth signal acquisition platform into one instrument, Tektronix offers a
reliable means to make fast, objective, and accurate video measurements.
Product verification activities that previously took hours or days to complete can
now be completed in seconds or minutes. Offering near plug-and-play video
measurement capability, even unskilled operators can reliably assess HDTV
video output signal quality.

As a fully integrated video analyzer, the VM5000 Option HD offers simple
configuration menu settings that can readily be recalled or copied, eliminating
complicated oscilloscope set-ups, tedious manual measurements, and time-con-
suming results correlation exercises. Product quality is enhanced because reliable
HDTYV test results can be reliably generated, easily replicated with other
VMS5000 Option HD instruments, and readily communicated across a global
engineering, supply, or sales organization.

The VMS5000 Option HD offers intuitive Windows based configuration and
measurement results menus for easy operation with minimal training time. A
10.4 in (264 mm) Color Display provides a bright, clear, and crisp display of
waveforms and measurement results. Users can easily navigate through the
logically arranged configuration and results menus, and make selections via
radio buttons or an on-screen keyboard utilizing the included USB mouse.

VMS5000 Option HD Automatic Video Measurement Set User Manual
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Firmware Upgrade

Tektronix may offer firmware upgrade kits for the VM5000 Option HD
instrument. Contact your Tektronix service representative for more information

(see Contacting Tektronix on page xi).

Recommended Oscilloscope Probes

Table 1-1 lists the recommended oscilloscope probes to use when using the

instrument as an oscilloscope.

Table 1-1: Recommended probes

Probe type Tektronix probe
Passive, 10X, 500 MHz P5050
Passive, 100X, 250 MHz, high voltage P5100
Passive, 1000X, 100 MHz, high voltage P6015A
Passive, 15 MHz, 1X P6101B
Active, DC to 1.0 GHz, FET high speed digital, P6243

for CMOS/TTL technology

Active, DC to 1.5 GHz, FET high speed digital, P6245

for all technologies

Active, DC to 400 MHz, FET, high bandwidth differential | P6246
Active, DC to 1.0 GHz, FET, high bandwidth differential | P6247
Active, DC to 1.7 GHz, FET, high bandwidth differential | P6248
Active, 100 MHz, high voltage differential P5205
Active, 50 MHz, high voltage differential P5210

AC Current P6021

AC Current P6022
DC/AC Current AM5030S
High Speed Current CT-1/CT-2
Current, 250 KHz to 2 GHz, 50 €2 input, AC Only, CT-6

for temporary in-circuit installation

Current, DC to 50 MHz, 15 ADC TCP202
Low Capacitance, 20X, 3 GHz P6158
Current Measurement TCPA3000
Current Measurement TCPA4000
Differential Preamp ADA400A
High Voltage Differential P5200

VMS5000 Option HD Automatic Video Measurement Set User Manual
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Table 1-1: Recommended probes (Cont.)

Probe type Tektronix probe
Optical/Electrical Converter P6701B
Optical/Electrical Converter P6703B

1-4 VMS5000 Option HD Automatic Video Measurement Set User Manual



Installation

This section addresses instrument installation:

Unpacking on page 1-5

Checking the Environment Requirements on page 1-6
Connecting the Mouse on page 1-7

Powering On the Instrument on page 1-8

Shutting Down the Instrument on page 1-8

Creating an Emergency Startup Disk on page 1-9
Backing Up User Files on page 1-9

Installing Software on page 1-10

Connecting to a Network on page 1-11

Adjusting Display Contrast on page 1-12

CAUTION. Be sure to create your emergency startup disk as described on
page 1-9. You may need that disk if you ever need to reinstall Windows 2000 on
the instrument hard drive.

Unpacking

Refer to the tables beginning on page 1-19 for a list of the options and accesso-
ries shipped with this instrument. Remember to fill out and send in the customer
registration card.

VMS5000 Option HD Automatic Video Measurement Set User Manual 1-5
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Checking the Environment Requirements

Site Considerations

/N

Read this section before starting any installation procedures. This section
describes site considerations, power requirements, and ground connections for
your instrument.

The instrument is designed to operate on a bench or on a cart in the normal
position (on the bottom feet). For proper cooling, make sure that there is at least
three inches (76.20 mm) of clearance on the left side of the instrument. If you
need to access the instrument CD-RW drive, you will also need at least 5.1
inches (129.54 mm) of clearance on the right side of the instrument.

76.20 mm
(3.001in)
482.60 mm —>‘
(19.00 in)
(
330.20 mm
(13.00 in)
B
| 6 G 9

Figure 1-1: Instrument space requirements

CAUTION. To ensure proper cooling, keep the bottom and left side of the
instrument clear of obstructions.

Operating Requirements

1-6

The specifications in Appendix A list the power source, temperature, humidity,
and altitude operating requirements for the instrument.

VMS5000 Option HD Automatic Video Measurement Set User Manual



Installation

Connecting the Mouse

The instrument includes a USB (Universal Serial Bus) mouse. You can plug the
mouse into any of the four available USB ports. The USB ports and other PC
peripheral connection points are shown in Figure 1-2. Refer to the TDS5000B
Quick Start User Manual for additional connection information.

Keyboard —— PS/2 mouse
PC SVGA output
Centronics printer
RS-232 —
USB — Ethernet
Microphone in Audio line in
Audio line out
GPIB
Scope VGA output

Figure 1-2: Locations of VM5000HD connectors

NOTE. For best performance, plug the USB devices directly into the USB
connectors on the instrument chassis, rather than connecting the devices serially.

You can connect or disconnect USB mouse, keyboard, or other USB devices with
the power on. If your USB mouse locks up, disconnect and reconnect the USB
connector to restore normal operation.

CAUTION. To avoid product damage, shut down the instrument and disconnect

A the power cord from the power source before connecting any accessories other
than USB devices. If the instrument front panel and/or touch screen does not
respond, press the On/Standby switch for at least 5 seconds to cycle power.
See Shutting Down the Instrument on page 1-8.

VMS5000 Option HD Automatic Video Measurement Set User Manual 1-7



Installation

Powering On the Instrument

Follow these steps to power on the instrument for the first time.

CAUTION. To ensure proper operation, connect the keyboard, mouse, and other
! accessories before applying power to the product the first time.

1. Connect one end of the instrument power cord to the instrument and the
other end to a power source.

2. Push the On/Standby switch to power on the instrument (see Figure 1-3 for
the switch location).

0'p

o oo 00
o mOb o

g
=
g
=
=

00 00000

g
On/Standby —»|[
switch H @l@ @ @ @J

Figure 1-3: On/Standby switch location

Shutting Down the Instrument

To shut down the instrument, push the front-panel On/Standby switch. The
instrument preserves settings and then starts a shutdown process (including a
Windows shutdown) to put the instrument into standby mode. Avoid disconnect-
ing the power cord or power source to shut down the instrument.

NOTE. If you remove power instead of using the On/Standby switch to shut down
the instrument, the instrument will be in the factory Default Setup when powered
on the next time.

If the shutdown process does not start immediately after pushing the ON/Standby
switch, push and hold the On/Standby switch for up to 20 seconds to start the
shutdown process.

To completely remove power to the instrument, push the On/Standby switch and
then disconnect the power cord from the power source.
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Creating an Emergency Startup Disk

VAN

Backing Up User Files

Now that you have completed the basic installation process, you should create an
emergency startup disk. The emergency startup disk contains basic files to restart
your instrument in case of a major hardware or software failure. The disk also
contains files that you can use to check and format the hard disk.

CAUTION. Create this disk and store it in a safe place. It may help you recover
your Windows 2000 installation without rebuilding the entire instrument hard
disk.

Follow these steps to create the emergency startup disk for a Windows 2000
instrument:

1. Minimize the instrument application by selecting Minimize in the File
menu.

2. From the Windows taskbar, select Start > Programs > Accessories
>System Tools > Backup.

3. In the Welcome display, click Emergency Repair Disk.

4. Insert a 3.5 in disk into the disk drive, and follow the on-screen instructions
to create the startup disk.

Always back up your user files on a regular basis. Use the Windows Backup tool
to back up files stored on the hard disk. The Backup tool is located in the System
Tools folder in the Accessories folder.

Use these steps to back up your files:

1. Exit the instrument application by selecting the File menu Exit command.
2. Click the Windows Start button.

3. Select Programs > Accessories > System Tools > Backup.

4

Use the Backup Wizard to select the items you want to back up and the
destination. The destination can be the floppy drive or a third-party storage
device over one of the side-panel ports.
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Installing Software

Software Release Notes

1-10

VM5000HD Remote
Command Information

The instrument system and application software is preinstalled at the factory. If
you have to reinstall the software for any reason, refer to the instructions that
accompany the CD-ROMs shipped with the instrument.

Read the software release notes (README.TXT) on the product software
CD-ROM before performing installation procedures. This file contains additional
information that supercedes other product documentation.

To view README.TXT, start the Windows Notepad accessory and open the file
from the VM5000HD Automatic Video Measurement Set Product Software
CD-ROM.

The GPIB programmer information is available in Appendix C.

Programmer information for the rest of the instrument functions is available as a
.pdf file on the TDS5000B Series Product Software CD-ROM.
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Desktop Applications  You can install desktop application software on the instrument. The instrument
has been tested with the following software products installed:

®  Microsoft Office 98 (Word, Excel, PowerPoint, and so forth)
m  MathCad
= MATLAB

Other software products may be compatible but have not been tested by
Tektronix. If the instrument malfunctions after you install software, uninstall the
software and then reinstall the instrument software (if necessary) to restore
proper operation.

Exiting the instrument Application. Before installing other desktop applications,
exit the instrument application. To do this, select the File > Exit command.

Connecting to a Network

You can connect the instrument to a network to enable printing, file sharing,
internet access, and other communications functions. Before you make the
connection, do the following steps to enable network access to the instrument:

1. Begin with the instrument power off.

2. Attach a keyboard and mouse to the instrument.
3. Power on the instrument.
4

As the instrument begins to boot, press the keyboard F2 key repeatedly until
the message “Loading SETUP” appears.

S. In the BIOS Setup Utility, use the keyboard right-arrow key to highlight the
Advanced menu at the top of the screen.

6. Use the arrow down key to highlight Peripheral Configuration in the
Advanced screen, and then press Enter.

7. Use the arrow down key to highlight LAN Device in the Peripheral
Configuration screen, and then press Enter.

8. Use the arrow up or down key to highlight Enabled, and then press Enter.
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10.

Press the F10 key to save and exit. Confirm the Save of Configuration
changes when you are prompted on screen.

Use the Windows network setup utility to define the instrument as a network
client, and configure it for your network. You can find the network setup
utility in the Windows Start menu if you select Settings > Control Panel
and then double click Network. You should consult your network adminis-
trator for specific instructions to make these settings.

NOTE. If you want to disable network access for the instrument, perform the
above procedure, except substitute Disabled for the command listed in step 8.
The instrument will boot faster with network access disabled.

Adjusting Display Contrast

1-12

If you find that the instrument screen is too bright or too dark, use these steps to
adjust the LCD display contrast to your preference. You must have a mouse
attached to perform this procedure.

1
2
3
4.
5
6

N

Right click with the mouse on the Windows desktop.
Select Properties.

Select the Settings tab.

Click Advanced.

Select the Color tab.

Adjust slider control for desired gamma setting. The screen brightness will
change as you move the slider control.

Click Apply.
Click OK.
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Incoming Inspection

This section contains instructions for performing a self test and functional
verification of the instrument. These procedures verify that the instrument is
operating correctly after shipment, but do not check product specifications.

If the instrument fails any test within this section, it may need service. To contact
Tektronix for service, see Contacting Tektronix on page xi of Preface.

Make sure you have put the instrument into service as detailed in Installation
starting on page 1-5.

Self Tests

This procedure uses internal routines to verify that the instrument functions and
was adjusted properly. No test equipment or hookups are required.

Equipment required | None

Prerequisites Power on the instrument and allow a 20 minute warm-up.

Perform these substeps to verity internal diagnostics:
1. Display the system diagnostics menu as follows:

a. If the instrument is in the toolbar mode, click Menu (far right toolbar
button) to switch to menu bar mode.

b. From the Utilities menu, select Instrument Diagnostics to open the
Instrument Diagnostics control window.

c. Ensure that ALL is selected from each drop-down list.
2. Run the system diagnostics as follows:
a. Disconnect all input signals from all four channels.
b. Click Run in the Instrument Diagnostics control window.

The internal diagnostics do an exhaustive verification of proper instrument
function, taking five to fifteen minutes. When complete, the resulting status
appears in the diagnostics control window.

3. Verify that no failures are found and reported: The instrument should pass
all tests. If any failures occur, record the failure information and contact your
local Tektronix service personnel for more information.

4. Run the signal path compensation routine as follows:
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a. From the Utilities menu, select Instrument Calibration to open the
Instrument Calibration control window.

b. Click Calibrate to start the routine.

c. Confirm signal path compensation returns passed status: Signal path
compensation may take up to ten minutes to run. Verify that the word
Pass appears in the Status text box.

5. Click Close to exit the Instrument Calibration control window.

Functional Test

This procedure uses the output from a PC VGA video card to test the VM5000
Option HD application functionality.

Equipment required | VM5000 Option HD

Sync Combiner cable assembly, Tektronix part number 012-1664-XX
75 Q precision BNC terminations (3)

BNC “T” connectors (3)

A PC with a CD drive and a video graphics card capable of displaying
an image at 1280 x 1024 at a 60 Hz refresh rate

NOTE. These procedures verify that the application features operate. They do not
verify that they operate within limits. Therefore, when the instructions in these
functional tests call for you to verify that a signal appears on screen “that is
about five divisions in amplitude” or “has a period of about six horizontal
divisions,” and so on, do not interpret the quantities given as limits.

Do not change the front-panel settings unless directed to by the procedure. If you
change front-panel settings, you may obtain invalid results. In this case, redo the
procedure from step 1.

When you are instructed to press a front-panel button or screen button, the
button may already be selected (its label is lighted). If this is the case, it is not
necessary to press the button.
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1. Set the PC monitor display properties by doing the following steps:

a.

b.

k.

L.

Power on the PC and its monitor.

Position the cursor anywhere in the desktop background area and click
the right mouse button to show the desktop menu.

Select Properties to show the Display Properties dialog box.
Select the Settings tab to show the display settings fields.

Set the Screen Area slider control to 1280 by 1024.

Set the color field to True Color (24 bit).

Select the Advanced button to open the advanced settings dialog.
Select the Monitor tab to display the monitor dialog.

Select 60 Hertz in the Refresh Frequency list.

Select OK to dismiss the advanced dialog box. Depending on your
Windows settings, the settings are applied immediately or you are
requested to reboot your computer.

Select OK to apply the changes or to reboot your system.

Select OK to dismiss the Display Properties dialog box.

2. Set the PC to generate the test signal by doing the following steps:

a.

Insert the VM5000 Option HD Application Software CD in the PC CD
drive.

Start the Windows Paint program (Start > Programs > Accessories >
Paint).

From within the Paint program, open the file
<cd-drive>: PCMatrix1280X1024P60.bmp.

Select View > View Bitmap to display the file as a full-screen image (no
window borders).

3. Turn off the monitor, and then disconnect the PCs monitor cable from the PC
VGA video card output connector.

4. Connect the 15-pin connector on the Sync Combiner cable to the PC VGA
video card output connector.
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S. Connect the other end of the Sync Combiner cable to the VM5000 Option
HD instrument inputs as shown.

VMS5000 Option HD

PC

PC VGA Out
i “D” Connector N

v
nc

o
5]
=
o
<L T,

\ 7

[DJD = BNC “T” connector @ =75 Q Termination

6. Power on the VMS5000 Option HD instrument and wait for it to complete the
power-on process.

7. Select File > Run Application > VMS5000HD to display the VM5000
Option HD application window.

8. In the application window, select File > Recall Default to load the applica-
tion default settings.

9. In the application window, select Configuration > Format to display the
Format view.

10. Select the SXGA/60 button.

11. In the application window, select Configuration > Operation to display the
Operation view. Uncheck (turn off) All Measurement Warnings.

12. Select the Channel 4 button in the Trigger area.
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13. In the application window, select the Run button to start the application
measurement process.

¥

The instrument begins taking measurements and displays a Color bars
measurement view listing measurement values similar to those shown below.

Results (mY)
A fLC) Fb/B F R

White  B92.2: E24 .13
e llawg
Cyran

Brean

hlage nta

Red
Blue
Black

Your actual measurement values will depend on your VGA output levels. They
will vary from the nominals (700 mV and 0 mV) by about +50 mV, but you
should observe the pattern shown in the screen capture above.

You have completed the VMS5000 Option HD functional verification procedure.
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Options and Accessories

This section lists the product options, standard accessories, and optional
accessories that are available for the instrument.

Options

You can order the options shown in Table 1-2 with the instrument.

Table 1-2: Instrument options

Hardware 18 Touch-screen interface
FHD Front panel removable hard drive
1K Scope Cart

655-4920-00 Thermal Printer-1P
Mounting 016-1946-XX | TDS5000B Series Rackmount Kit-1R

Software SM Serial Communications Mask Testing
CP2 TDSCPM2-ANSI/ITU telecom pulse compliance
software
DVD TDSDVD-Optical storage analysis software
ET3 TDSET3-Ethernet compliance test software
J2 TDSDDM2-Hard disk drive application software
J3E TDSJIT3E-Jitter and timing analysis software essentials
JT3 TDSJIT3-Jitter and timing analysis software with Rj/Dj
and BER
PW3 TDSPWR3-Power measurement software
USB TDSUSBS-USB2.0 compliance test software only
Service C3 Calibration Service 3 years
C5 Calibration Service 5 years
D1 Calibration Data Report

with Option C3 | Calibration Data Report 3 years

with Option C5 | Calibration Data Report 5 years

R3 Repair service 3 years

R5 Repair service 5 years
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Accessories

This section lists the standard and optional accessories available. The accessories
listed in Table 1-3 are shipped standard with the instrument.

Table 1-3: Standard accessories

Accessory Part number
TDS5000B Series Digital Phosphor Oscilloscopes Quick Start User Manual
English (Option L0) 071-1355-XX
French (Option L1) 071-1357-XX
German (Option L3) 071-1358-XX
Japanese (Option L5) 071-1356-XX
Korean (Option L9) 071-1359-XX
Russian (Option L10) 071-1401-XX
Simplified Chinese (Option L7) 071-1360-XX
Traditional Chinese (Option L8) 071-1361-XX
Accessory Pouch 016-1935-00
Keyboard 118-9402-00
Getting Started with OpenChoice Solutions Manual with CD 020-2513-XX
Important Documents Folder Not orderable

Includes Certificate of Calibration documenting NIST traceability, 2540-1
compliance, and 1ISO9001 registration

Front Cover 200-4651-00

Power Cord

North America (Option AQ) 161-0104-00
Universal Euro (Option A1) 161-0104-06
United Kingdom (Option A2) 161-0104-07
Australia (Option A3) 161-0104-05
240V North America (Option A4) 161-0104-08
Switzerland (Option A5) 161-0167-00
Japan (Option A6) 161-A005-00
China (Option A10) 161-0306-00
No power cord or AC adapter (Option A99)

Optical Wheel Mouse 119-6936-XX

VM5000 Option HD Product Software CD-ROM 063-3768-XX
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Table 1-3: Standard accessories (cont.)

Accessory Part number
TDS5000B Series Product Software CD-ROM 063-3692-XX

Includes: application, online help, TDS5000B Series Programmer Online

Guide (GPIB online help and PDF), Specifications and Performance

Verification PDF, release notes,VISA information, and other related

documentation.
TDS5000B Series Operating System Restore CD-ROM 063-3693-XX
Optional Applications Software for Windows-Based Oscilloscopes CD-ROM [ 020-2450-XX
and manuals
Signal Sources Disks 020-2507-XX
LabVIEW 30-day Evaluation Copy 020-2476-XX
MATLAB 30-day Evaluation Copy 063-3609-XX
One 500 MHz,10x passive probe per channel P5050
One BNC T Adapter, Male to 2 Females 103-0030-00
75 Ohm Coaxial Termination, BNC 011-0102-XX

The accessories in Table 1-4 were orderable for use with the instrument at the
time this manual was published. Consult a current Tektronix catalog for
additions, changes, and details.

Table 1-4: Optional accessories

Accessory Part number
TDS5000B Series Digital Phosphor Oscilloscopes Service Manual 071-1362-XX
Transit Case 016-1937-00
Video Display Clamp 013-0278-XX
Thermal Printer Paper 016-1897-00
Probe Calibration, Compensation and Deskew Adapter. Requires a 067-0405-02
separate pulse generator.

Power Deskew Fixture 067-1478-00
Extra Front Removable Hard Drive 065-0692-XX
P6101B 15 MHz 1X Passive Probe P6101B
Extra P5050 500 MHz 10X Passive Probe P5050
TCPA300, TCPA400 Series Current Measurement Systems (requires | TCPA300 / TCPA400
TCPA300 / TCPA400 style probe)

AMT75 1 GHz 75 W Adapter AMT75
AFTDS Differential Signal Adapter AFTDS
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Table 1-4: Optional accessories (cont.)

Accessory Part number
K420 Scope Cart with mouse accessory tray 436-0317-XX
TDS5000 Series, VM5000 Option HD rackmount kit 016-1887-XX
GPIB cable (3.3ft/1m) 012-0991-01
GPIB cable (6.6 ft/ 2 m) 012-0991-00
Centronics cable 012-1214-00
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Operating Basics

This section provides basic information about using the VM5000 Option HD.
More detailed measurement information can be found in the Reference section.

Input Signal Connection Requirements

Use only 75 Q coaxial cables to connect the video device under test to the
VM5000 Option HD instrument.

Install the included 75 @ terminations between the end of the coaxial cables and
the instrument input channels, using the included BNC “T” connectors. For
accurate frequency response measurements, it is important to attach the “T”
connector directly to the VM5000 Option HD input channel BNCs.

Direct connection to VM5000
Option HD input channel BNC

75 Q Precision
75 Q Coaxial end-line termination
cable 7 (011-0102-03)

o0 6]

BNC “T” connector
(103-0030-00)
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Connecting Input Signals

3-Wire Video with

Composite Sync, Setup 1

2-2

Signal source
(Tektronix MTX100)

o o0 O

O <=
S (S

Use the following diagrams to determine the optimum input signal setup for your

measurement needs.

Use this setup for testing 3-wire component analog video signals (Y/G, Pb/B,
Pr/R) with the composite sync signal on Y/G, triggering the instrument on
channel 1 (the default trigger setting). This setup provides the most accurate
frequency response information, but limits noise measurement on Y/G to -65 dB

(30 MHz noise bandwidth).

Set top box

Modulator

Y/G

ol

il

Pu/B

P

Pr/R

P

VM5000 Option HD

u CH1 |cH2 |CcH3 cmu

Y/G PyB PJ/R

[[IU = BNC “T” connector @ =75 Q Termination
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3-Wire Video with  Use this setup for testing 3-wire component analog video signals (Y/G, Pb/B,
Composite Sync, Setup2  Pr/R) with the composite sync signal on Y/G, triggering the instrument on
channel 4. This configuration provides more accurate low-level (below -60 dB at
30 MHz bandwidth) noise measurements than setup 1. Frequency response
measurements on the Y/G will be degraded by approximately 0.04 dB (0.5%) at
30 MHz due to the additional loading from the CH4 input.

VM5000 Option HD
Q
Signal source p o ‘; =
(Tektronix MTX100) < 75Q
1 Cable
o ooo Set top box !' L~
>
8 @OD Modulator ° =TT~ =~— BNG‘T”
O Y= { J
I A A U CH1 [cha [cHa [ora J connector
om [ ] P P ¢ I
PR
Po/B Y/G
]
H]ﬂ = BNC “T” connector @ =75 Q Termination
NOTE. Be sure to set the trigger channel to channel 4; the default trigger
channel is channel 1. If you do not change the trigger setting (Configuration >
Operation), you will see signal warning messages and be unable to take
measurements.
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4-Wire Video with

Separate Composite Sync

Signal source
(Tektronix MTX100)

o o0 =™

O <=
S (19U

Use this setup for testing 4-wire component analog video signals (Y/G, Pb/B,
Pr/R) with the composite sync signal on a separate output line. For CH4,
termination is optional. For CH4 only, you can use no termination or a 75 @
termination of lower accuracy than the 75 Q terminations that are provided with
the instrument.

VMS5000 Option HD

Video device
under test (DUT)

Modulator

Y/IG PyB P/R Sync {

ol

CH1

(e

CH2 ‘CHS ‘om U

Y/G PyB PJR Sync

[Dﬂ = BNC “T” connector @ =75 Q Termination

NOTE. Be sure to set the trigger channel to channel 4; the default trigger
channel is channel 1. If you do not change the trigger setting (Configuration >
Operation), you will see signal warning messages and be unable to take
measurements.
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VGA PC Video Card Signal ~ Use this setup for testing 3-wire component analog video signals (Y/G, Pb/B,
Measurement Setup  P1/R) without the composite signal on Y/G, and triggering the instrument on
channel 4. Use the special VGA sync combiner cable to connect the PC video

card to the instrument. (Use this setup for the Functional Tests beginning on
page 1-14.)

VMS5000 Option HD

PC

PC VGA Out
:‘ “D” connector Q

) ) ]
\;E FEEECEEFRorie ey Green Red
cable cable
Blue HV
cable Sync
\ y,

H]ﬂ = BNC “T” connector H =75 Q Termination

NOTE. Be sure to set the trigger channel to channel 4; the default trigger
channel is channel 1. If you do not change the trigger setting (Configuration >
Operation), you will see signal warning messages and be unable to take
measurements.
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The Matrix Test Signal

2-6

The Matrix test signal, shown below, is provided with the accessory Signal
Source Disks provided with this product. It incorporates all analog HD video
signal requirements into different line numbers within one test pattern field.
Using a single test pattern eliminates the need to change test signals when doing
different measurements. All you need to change is line numbers. Use the setup
file (.vmset) that matches the format of the Matrix test signal you are using; this
provides appropriate line numbers as default settings for each measurement type.
See page F-1 for a full description of the files on the Signal Source Disks.

I
{

il
-
||I% -

il
|

H \‘ H\’H JEII

&I & LI GLILY I

Signal Format Signal Format Signal Format
1. Color bars Al 6. Sweep YPbPr 11. Valid ramp Al

2. Sweep RGB 7. 30 MHz MB YPbPr 12. Flat field: 0% black | All

3. Sweep RGB 8. 15MHz MB YPbPr 13. Flat field: 50% grey | All

4, Multiburst RGB 9. Windowed sweep RGB 14. Flat field: 100% white | All

5. Sweep YPbPr 10. Windowed sweep YPbPr
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Starting the Application

Make sure you have set up the input signal sources before taking measurements (see page 2-9).

1. Power on the instrument. The
instrument displays the default
main screen.

2. In the menu bar, select File >
Run Application > VMS5000
Option HD.

The instrument reduces the
waveform area to the upper half
of the display, and opens the
VMS5000 Option HD applica-
tion in the lower half of the dis-

play.

Reference Waveforms 3
Instrument Setup...
Recall Default Setup

WEO00HD

Page Setup...
Print Preview
FPrint.... Ctrl+P

Fuennit Sehn

File  Edit  “ertical Horzddcq  Trig Display  Cuwrsors Meagwre  Math Utilites  Help

Trig Holdoff

Conflguration  Results  Utilities  Help

Format Color Space

420F /60 “YPBFPT
S7T6P /50 RGH
F20P /B0
10201 F 60
10201 # 50

SERGAJED
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The VM5000 Option HD Application User Interface

2-8

. Menu bar: Selects setting con- E>@ File Configuration Resufts Utiities Help

. Application view: Displays

. Run Button: Sets up, starts tak-

. Stop button: Halts the measure-

trols and results information to
display in the Application view.

Format Color Space

420F /50 PP

ATGFP /60 RGH

TZOF /50
10201 /60

configuration controls and mea-
surement results.

10201 /60

SAGAED

ing measurements, and displays
results.

ments.

. Hide button: Restores the main display to full-screen and hides the application window behind

the main display.
To restore the application window after hiding it, select the App button on the main display.

To access the MS Windows desktop (for viewing reports), select Hide. In the main display, select
File > Minimize, and then select the application Hide button again.

. Exit button: Exits (closes) the application and returns the instrument to the default main display.
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Measurement Steps Overview

1. Set the input signal format standard (such as 1080i/60) and color space (Y Pb Pr or RGB) by us-
ing the Configuration > Format menu (page 2-9).

2. Select one or more measurements to take by using the Configuration > Measurements menu
(page 2-10).

3. Set the measurement run operations, such as run mode and trigger channel, by using the Config-
uration > Operation menu (page 2-11).

4. Select the Run button to take and view measurements (page 2-13).

5. Save measurement results by using the Utilities > Generate Reports menu (page 2-17).

Setting the Input Signal Format

1. Select Configuration
Configuration > Format. E> ® Format
Measurements
Operation

@Fne Configuration  Results  Utilities  Help

The application opens the For-
mat view. -

S76P /50

Format

720P /80
10801/ 60
10801/ 50

SXBAIED

2. Select the appropriate video for- Color Space
mat for the signal you are mea- a80F 10 VEbRr
SllI‘iIlg. 7P £ 50 R&B

F2OP /a0

3. Select the appropriate color
space type for the signal you are
measuring.

A0E01 £ &0

10201 # 50

SXaGASED
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Selecting Measurements

1. Select Configuration
Configuration > Measure- Farmat
ments. ® lleasurements
Operation
2. Select from one to six measure- TS

ments, in any combination. Channel Delay
Color Bars
Multibiurst

il
Mon Linearity
Syne
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Setting the Measurement Run Operations

1. Select Configuration
Configuration > Operation. e —
Measurements
& Operation
The instrument displays the Op_ %’ File Configuration Results  LUtilities Help
eration VieW. These settings Setup And/Or Run Auto Scale Warning Reporti
control how the instrument sets Setup & FRun an
up and acquires measurements Setup Only ot
when you select the Run button. Run Only
Run Mode Trigger
Continuausly Channel 1
Once Channel 4
2. Select how the instrument sets Setup AndfOr Run

up and runs measurements.
Setup & Run

Setup Only

Fun Only

B Setup & Run configures the instrument settings and takes a measurement, for each selected
measurement, and for each measurement acquisition. Use this when taking multiple measure-
ments that require different instrument setups.

B Setup Only configures the instrument for a measurement but does not take the measurement.
Use this to set up customized settings. Try out your settings by pressing the Run button, make
adjustments as needed (for example, change the horizontal scale), and then select the Run
button again. Once you are satisfied with your customized setup, use the Run Only setting to
collect results.

®  Run Only takes a measurement using the existing instrument configuration. Designed for
taking measurements with custom settings (see Setup Only description above).
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3. Select how the application ac-
quires measurements (run
mode).

Continuoushy

Onge

®  Continuously continually takes measurements. You must select the Stop button to stop
measurements.

®  Once takes each selected measurement the number of times determined by the averaging
setting, then stops taking measurements.

4. Enable or disable waveform au- Auto Scale
toscaling. Auto Scaling adjusts
the vertical scale units so that
the input signals fill the grati-
cule as much as possible. Auto
Scaling occurs once for each se-
lected measurement.

Refer to page 3-7 for details.

On

Off

S. Select which instrument chan- Trigger
nel has the sync signal for trig-
gering.

Channel 1

Channel 4

If you use the wrong trigger
channel (and Signal Warnings is
on), you will get a signal warn-
ing. See the setup diagrams and
trigger requirements on

page 2-2.

6. Select which warning messages Vifarning Reporting

to display.
Measurement Warnings

See page 3-7 for more informa-

tion. I» Sighal Warnings
Results WWarmings
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Taking and Viewing Measurements

Make sure you have selected a signal format, selected one or more measurements, and configured the run
options before taking a measurement.

1. Select the Run button. E>

¥

%’File Configuration  Results  Utilities  Help

The instrument begins taking

measurements and displays the Color Bars Measurement Setup Results (mv)
; Fb/B
measurement results view for
the most recently-selected mea- (e it i
surement result. I
Average
J
2. To view the results for other Results

measurements, select the mea-
surement from the Results
menu. For example, to view the
Sync measurement results, se-
lect Results > Sync. Maoise

Mo Linearity

E> ® Sync

Channel Delay
Color Bars
Multiburst

The instrument displays the se- & File Configuration Results _Utities Help
lected measurement results. You Syne Measurement Setup
can only display results for
measurements that are selected Line Humber (@
in the Format > Measurements
view.
3. If you set the run operation to
Continuously, press the Stop E> L]

button to stop taking measure-
ments.
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Changing Line Number or Averaging on the Results Screen

2-14

3. Select the keypad icon to the

4. Use the indicated general pur-

1. Select a measurement from the Results

Results menu. For example, se-

Channel Dela
lect Results > Sync. g

Color Bars
Multiburst
MHoise

Mon Linearity

E> ® Sync

The instrument displays the se- & File Configuration  Results Utiliies Help
leCted measurement I'esults, Sync Measurement Setup Tri-Level Sync Results

Line Humber

Average

R

2. You can change the video signal Line: Humber

line number and the number of
measurements to average before e—
displaying results. The instru- I
ment stops measuring, changes
results to dashes, and uses the
new settings at the start of its
next measurement cycle. Refer
to page 3-8 for information on
line numbers and averaging.

To change a value, select the
field and enter a value by key-
board. You can also change val-
ues using one of these methods:

left of the field to display a
virtual keyboard to enter values
using the touch screen.

pose knob to change the value.
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Saving Measurement Setups

1.

Select File > Save.

The application displays the
Save dialog. The default save
location is C:\VM5000 Option
HD.

Select the Look In list to navi-
gate to a different directory oth-
er than the default save loca-
tion.

Enter a file name in the File
Name field. The instrument of-
fers an available file name (or
you can choose your own). It
automatically appends .vmset to
the file name of measurement
setup files.

Select Save to save the mea-
surement settings to the speci-
fied location and file name.

Recall Default
Recall...

Save...

o>

Minirmize

File name:

File name:

Files

VMS5000 Option HD Automatic Video Measurement Set User Manual
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Operating Basics

Recalling Measurement Settings

1. Select File > Recall.

Recall Default
Recall...

Save...

Minirmize

The application displays the Re- =iRecall
call dialog and lists all instru-
ment setting files that are pres-
ent in the default C:\VM5000
Option HD directory.

Cancel

2. Select the Look In: button to
navigate to a different directory

other than the default location
(if desired).

3. Select a file from those listed.

4. Enter a file name in the File
name: field or select a file from

the list.

5. Select Open to load the settings
file and configure the instru-
ment.
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Saving Measurement Results (Reports)

You can use the Generate Report function to save your measurement results.

1. Select Litilities

Utilities > Generate Report. E> Generate Report I

The instrument displays the
PO . Lilities: Report Generator
Utilities Report Generator view. —

AN | File Hame  [EE] C:MSO0DHDN Teld). it GatDetault

POF
Additional Information I

=17
Generation

Measurements
Al Selected Generate Repart

2. Select a report format. Which Format
format to select depends on
what you want to do with the
measurement results.

®  RTF: Use RTF (Rich Text Format) to create results data that you can incorporate into
documents.

®  PDF: Use PDF (Portable Document Format) to create PDF files of the measurement data for
distribution and viewing. PDF is especially useful for ensuring that the results cannot be
altered.

®  CSV: Use CSV (Comma-Separated Values) to create results data that you can insert into
spreadsheets or math software in which you can create limits to verify that your results are
within expected range.

3. Use the File Name field to spec- —
ify where you want to save the i tame PRI
report. Use the Browse button
to navigate to a specific loca-
tion. Use the Get Default button
to reset the file name to the de-
fault location and name for the
selected format.
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4.

2-18

Use the Additional Information
field to add notes into the report
file. You can enter up to 46
characters. For example: “Serial
Number 123456789012 tested
by J. Smith”

Use the Measurements buttons
to select which measurements
to save to a report.

» Additional Information |

Measurement s

= I

®  All: Creates a report with all the measurements you have run since starting the application
which have valid results in the results panels.

B Selected: Creates a report with only the measurements that are currently selected in the
Configuration> Measurements screen and that have valid results in the results panels.

Select Generate Report to save
the measurement results to the
specified format and location.

All selected measurements are
saved together in a single file;

each measurement has its own
area in the report.

Generation

zenerate Report
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Reference Overview

This chapter provides a detailed description of the VM5000 Option HD
instrument menus and measurements.

®  Menu descriptions. The table below lists the top level of the instrument
menus and the sections in this chapter that document those menus. The menu
descriptions include high-level descriptions of the six measurements.

®  Measurement details. Refer to page 3-15 for an in-depth description of each
of the six measurements.

Overview of menu descriptions

Menu Submenu Function Page
File Recall Default Restores default application measurement settings 3-3
Recall Recalls (loads) saved application measurement setups
Save Saves (writes) saved application measurement setups
Minimize Minimizes the application to the Windows task bar
Configuration Format Sets the input signal format 3-5
Measurements Selects measurements to take
Operation Sets measurement runtime options
Results Channel Delay, Color Bars, Multiburst, Displays the selected measurement results 3-8
Noise, Non Linearity, Sync Adjusts individual measurement settings
Utilities Generate Report Saves measurement results to specified file format 3-12
Help Help Topics Opens the VM5000 Option HD online help system 3-13
About VM5000HD Displays the application version number
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Menu Descriptions

The following tables list each menu item and its functions. Items in bold face
are the default application settings when first starting the application or after
doing a Recall Default operation.

The File Menu
Recalling a setup file changes the configuration; current measurements will stop
and results appear as dashes.
NOTE. To avoid losing unsaved measurement results, generate a report before
recalling the default setup or another .vmset setup file.
Menu item Function Setting or field Description

Recall Default

Recalls (loads) and

applies the default application measurement settings.

Recall

Recalls (loads) and applies application measurement settings
from the specified file.

Look in

Drop-down menu
VM5000HD

Sets the directory to list in the File list area.

File list area

Filename list field

Lists directories (folders) and setup files that are in the current
directory (as set by Look in).

File name

Text entry field

Field in which to enter an application setup file to load and apply.
You can also double-click on a file name in the File list area to
enter the name in the Flle Name field.

Files of Type

Drop-down menu
.vmset

Lists the valid setup file types. The only valid entry is .vmset.

To get valid test results, be sure to choose the appropriate setup
file for the signal source you are using. For example, for the
Option SS Matrix signal source file Tek1080iMatrix.trp, be sure to
use the Tek1080iMatrix.vmset setup file. The correct .vmset setup
file will have the correct line numbers for each measurement as
the defaults.

Open

Loads and applies the specified instrument setting file.

Cancel

Closes (exits) the Recall dialog and does not load or apply any
settings.

Save

Saves (writes) the current application measurement settings to the specified file name and directory.

All of the Save dialog functions are the same as those for the Recall dialog except for the Save button.
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Menu item Function Setting or field Description
Save Saves the application measurement settings to the specified file
directory (as set by Look in) and file name (as entered in the File
name field) as file type .vmset.
Minimize Minimizes the application to the Windows task bar.

3-4
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The Configuration Menu

All the selected measurement results will appear as dashes any time you change
any the following configurations:

®  Format
®  Color Space
m  Trigger

If you change a configuration while running a measurement or a setup, the
measurement or setup will stop.

Recalling a setup file changes the configuration; current measurements will stop
and results appear as dashes.

NOTE. To avoid losing unsaved measurement results, generate a report before
changing any configuration parameters other than selecting measurements or
turning warnings on or off.

Menu item Function Setting or field Description
Format Sets the video input signal format. The Format setting also affects other measurement settings, such as the video
signal line number to use when taking measurements.
Format 480P / 60 Sets the input signal format.
576P | 50
720P | 60
10801 / 60
10801 / 50
SXGA /60
Color Space YPbPr Sets the input signal color space type.
RGB
Measurements Selects the video signal measurements to take. You can select from one to six measurements, in any combination.
Measurements Channel Delay Selects from one to six measurements, in any combination.
Color Bars When you click the Run button, the selected measurements will
Multiburst be taken. The results of the measurements you select here will
Noise be included in any report you generate, if you select Utilities >
Non Linearity Generate Report and then set Measurements to Selected.
Sync

For a detailed discussion of measurements, refer to page 3-15.
For a high-level overview of measurements, refer to page 3-8.

VMS5000 Option HD Automatic Video Measurement Set User Manual 3-5



Menu Descriptions

Menu item

Function

Setting or field

Description

Operation

Sets the measurement runtime options, including test run mode, input trigger channel, and warning message

display.

Setup And/Or
Run

Setup & Run

Automatically configures the instrument settings and takes a
measurement, for each selected measurement, and for each
measurement acquisition. Use this when taking multiple
measurements that require different instrument setups.

Setup Only

Configures the instrument for a measurement but does not take
the measurement. Use this to set up customized settings.
Customized settings might include changes to the instrument
Horizontal or Vertical front panel controls to display and measure
a non-supported video signal standard.

Try out your settings by pressing the Run button, make
adjustments as needed (for example, change the horizontal
scale), and then select the Run button again. Once you are
satisfied with your customizations, use the Run Only setting to
collect results.

Run Only

Run Only Uses the current instrument and application settings to
take a measurement. Use this for taking measurements after
setting up the instrument using Setup Only to create custom
settings.
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Menu item Function

Setting or field

Description

Run Mode

Continuously

Continuously continually takes measurements, in the order the
measurements are listed in the Configuration > Measurements
view. You select the Stop button to stop measurements.

Once

Takes each selected measurement the number of times required
for the averaging you have selected, and then stops taking
measurements.

Auto Scale

On
Off

Enables or disables waveform Auto Scaling. Auto Scaling adjusts
the vertical scale units so that the input signals fill the entire
graticule as much as possible without going out of range. Auto
Scaling occurs once for each selected measurement.

If you are doing only one type of measurement and change the
amplitude of the signal, you may need to auto-scale again: set
Auto Scale to Off and then to On again. If you don't re-auto-scale
in this way, then you might get bad results, inefficient use of the
dynamic range, or your signal may be out of range.

If you are using custom instrument settings (for example,
changes to Vertical or Horizontal settings made from the
instrument front panel or from remote GPIB commands), you
should turn Auto Scaling Off.

If you are sure your signal is set up correctly and you want to
make further measurements in a high speed production line, set
Auto Scale to Off.

Trigger

Channel 1
Channel 4

Sets the input channel on which to trigger the instrument. Refer
to the setup illustrations starting on page 2-2 for appropriate
trigger channel settings.

Warning
Reporting

Measurement Warnings
Signal Warnings
Results Warnings

Sets which warning messages to display on the instrument
screen while taking measurements. All warning messages are
enabled by default. Clear a warning message check box to
disable displaying warning messages.

Measurement warnings include the most general information
about potential problems in making the measurement. Signal
warnings appear if signals are absent or change. If there are
some valid results, Results warnings let you know if some of the
displayed results may not be valid. A Results warning message
box also tells you which types of test results are included in a
report you have just generated.

If warnings are selected, message boxes may appear on screen,
requiring you to click OK. To avoid interruptions to your testing,
disable all of the Warning reporting, especially if you are using
the GPIB interface.
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The Results Menu

If you change the Line Number or Average values for any measurement, or if
you change the Filter configuration in the Noise measurement, then that the
changed measurement will stop running and its results will change to dashes.

All the selected measurement results will appear as dashes any time you change
any the following configurations:

B Format
®  Color Space
m  Trigger

If you change a configuration while running a measurement or a setup, the
measurement or setup will stop.

The Average setting interacts with your choices for the Run Mode. For example,
if you select Once for the Run Mode and you set the averages to 2, then when
you select the Run button, each selected measurement will run twice and then
stop. On the other hand, if you select Continuously for the Run Mode and 2
averages, then when you select the Run button, each selected measurement will
run twice, display results, and then continue running and updating the results for
every two measurements.

If you are using Matrix signal source files from the standard-accessory Signal
Source Disks, be sure to use the appropriate matching .vmset setup file, if
necessary, to get the correct default values for Line Number for each measure-
ment. See page F-1 for more information about the signal source files.

For a detailed discussion of measurements, refer to page 3-15.

Menu item

Function

Setting or field Description

Channel Delay

Measures the time variation between the three video channels. The instrument measures the crossings of all three

channels.

Channel Delay
Measurement
Setup

Line Number Sets the video signal line number to measure. The default value
depends on the input signal format as set by Configuration >
Format, and is based on using the Matrix test signal to generate
the test signal.

Average: 1 Sets the number of acquisitions over which to calculate an
average measurement value.

Results (ns)

Displays the time variation, in nanoseconds, from channel 1 to
channel 2, from channel 2 to channel 3, and from channel 3 to

channel 1.
Color Bars Measures all eight color levels of the three video channels. The instrument locates and measures the back porch
signal of each channel, and then measures each channel’s color values relative to that channel’s back porch level.
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Menu item Function Setting or field Description
Color Bar Mea- Line Number Sets the video signal line number to measure. The default value
surement Setup depends on the input signal format as set by Configuration >
Format, and is based on using the Matrix test signal to generate
the test signal.
Average: 1 Sets the number of measurements acquisitions over which to
calculate an average measurement value.
Results (mV) Displays eight color values, in mV, for each channel (24
measurements total).
Multiburst Measures the video channel frequency response and amplitude. The instrument measures the flag pulse on each
channel to determine and measure the six burst frequencies with the largest amplitude.
Channel Delay Line Number Sets the video signal line number to measure. The default value
Measurement depends on the input signal format as set by Configuration >
Setup Format, and is based on using the Matrix test signal to generate
the test signal.
Average: 1 Sets the number of measurements acquisitions over which to
calculate an average measurement value.
Multiburst Mea- Displays the flag signal value (in mV) for each channel in the first
surement Results display row. The following six rows list the frequency (in MHz)
and amplitude (in dB) of each channel, for each of the six burst
signals.
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Menu item Function Setting or field Description
Noise Measures video signal noise using one of three filter settings.
Noise Measure- | Line Number Sets the video signal line number to measure. The default value
ment Setup depends on the input signal format as set by Configuration >
Format, and is based on using the Matrix test signal to generate
the test signal.

Average: 1 Sets the number of measurements acquisitions over which to
calculate an average measurement value.

Filter off Disables (turns off) all noise signal filtering. Use this setting to
measure broadband noise without any filtering.

Unified Weighting Enables (turns on) unified weighting noise signal filtering. Use
this setting to measure noise with the psychovisual weighting
established by CCIR Recommendation (Rec) 576-2, adjusted for
the selected video format.

Unweighted w/ Enables (turns on) unweighted noise signal filtering and activates

Bandwidth the filter bandwidth field. Use this setting to remove high
frequency noise from your signal.

Bandwidth Hz Sets the bandwidth filter cutoff frequency. Selecting Unweighted
activates this field. The default value depends on the input signal
format as set by Configuration > Format.

Results Displays the noise measurement results for each channel in dB

(relative to peak white) and mV.

Non Linearity

Measures channel signal linearity based on a ramp or five-step linearity test signal. If using a ramp signal, the
instrument divides the ramp signal into five values to determine the equivalent step values. The instrument then
measures the bottom, individual step, and top values of the test signal, and compares these values to a nominal
value to determine the percent of deviation of the test signal from the nominal signal.

Non Linearity Line Number Sets the video signal line number to measure. The default value
Measurement depends on the input signal format as set by Configuration >
Setup Format, and is based on using the Matrix test signal to generate
the test signal.
Average: 16 Sets the number of measurements acquisitions over which to
calculate an average measurement value.
Results (%) Displays the percent of deviation of the test signal from a nominal

signal value, as a percentage, for each step on each channel.

Sync Measures the sync signal timing and voltage values. The instrument measures the sync signal rise and fall times

(at the 10% and 90% signal amplitude levels) and the sync pulse width (at the 50% signal amplitude level) to

determine the signal timing values.

Sync Measure- Line Number Sets the video signal line number to measure. The default value

ment Setup depends on the input signal format as set by Configuration >
Format, and is based on using the Matrix test signal to generate
the test signal.
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Menu item Function

Setting or field

Description

Average: 1

Sets the number of measurements acquisitions to take and then

calculate the average measurement value.

Tri-Level Sync
Results

Displays the sync signal timing values in ns, and the signal levels

inmV.
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The Utilities Menu
NOTE. To avoid losing unsaved measurement results, generate a report before
recalling a .vmset setup file or changing any configuration parameters other
than selecting measurements or turning warnings on or off.
Menu item Function Setting or field Description

Generate Report

Save (write) measu

rement results in three popular data formats.

Format RTF Use RTF (Rich Text Format) to create results data that you can
incorporate into documents.
PDF Use PDF (Portable Document Format) to create PDF files of the
measurement data for distribution and viewing.
CSv Use CSV (Comma-Separated Values) to create results data that
you can insert into spreadsheets or math software.
File Name Text entry field Field in which to enter the report file name.
C:\VM5000HD\TekO.rtf
Browse Selects the location to which to write (save) the report.
Get Default Sets the report write directory to the default location and name
(C:\VM5000HD\TekO.rtf).
Additional Text entry field Adds a brief note into the report file. You can enter up to
Information 46 characters.
Measurements Al Creates a report with all the measurements that you have run
since starting the application.
Selected Creates a report with only the measurements that are currently
selected in the Configuration > Measurements screen.
Generation Generate Report Writes the specified measurement data in the selected report

format to the specified location.

3-12
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The Help Menu
Menu item Function Setting or field Description
Help Topics Opens the VM5000 Option HD online help window that provides you with application information on your
instrument screen.
About Displays a VM5000 Option HD dialog that contains the application software version number.
VM5000HD
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Detailed Measurement Information

For a high-level procedure for how to take a measurement, refer to page 2-9.

For a high-level overview of all the measurements, refer to the table beginning
on page 3-8.

The following information applies to all measurements.

Matrix Signals and Line Numbers

Averaging

The matrix signals provided with the standard-accessory Signal Source Disks
(see page F-1) provide appropriate signals for all measurements. See the
Readme.txt files on the disks for extensive information about the files provided.

When using Tektronix supplied matrix test signals, if a .vmset file is provided
for that format of matrix test signal, be sure to use the default line numbers in the
associated .vmset file (File > Recall...). Otherwise, under most circumstances,
use the instrument default line numbers (File > Recall Defaults).

For example, when using the ATSC transport stream file:
Tektronix1080iATSCMatrix.trp,

you should select File > Recall... and then navigate to where you have saved the
setup file:

Tektronix1080iATSCMatrix.vmset.

The line numbers in this setup file may be used for all formats including 10804,
720p, and 480p in both YPbPr and RGB.

For the equivalent matrix test signal .DNL from a Tektronix TG700 video
generator, use the default settings.

The higher the averaging, the lower the variance of the measurement in the
presence of noise or other transient signal components. Set the averaging higher
if you would like to reduce the fluctuations in the measurement results.

The instrument averages results, not input waveforms. (If, on the other hand, the
Noise waveforms were averaged instead of the Noise results, the noise results
would appear lower than they should. Because the instrument averaging results,
this problem is avoided.)
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Measuring Channel Delay

3-16

Signal Source

Interpreting Results

Channel delay measurement is used to verify relative timing of the three
channels of video. Nominal channel delay is zero between all channels.
Deviations from zero correspond to decreased video quality. For example, the
greater the delay between channels, the more likely the edges in video will be
perceived as distorted. Using a narrow band signal, the delay at a particular
frequency band can be measured and thus group delay can be obtained.

In addition, channel delay is a function of relative cable lengths for each of the
channels. Thus, if a splitter is used at the video source output, delay due to cable
length mismatch can be measured.

You can use the matrix signal, or you can use a signal with high cross-correlation
between each pair of channels to be tested. The default signal is the multiburst
signal used for multiburst measurement, but many other types of signals can be
used, including sweeps and even some live program material. If the cross-cor-
relation is high enough for at least one pair of channels, the measurement results
will display. Otherwise, running the measurement will result in “---"" for each
channel. If warnings are enabled, low correlation between channels will result in
associated warnings.

A positive number indicates that the first signal arrives later than the second
signal. For example, Y to Pb delay of 4.03 ns means that the signal in the Y
channel is delayed 4.03 ns relative to Pb. However, the signals may contain
distortions, which create different delays for different portions of the video line.
In such a case, the measurement result is the delay compensation required to
maximize the cross-correlation of the second channel with the first, generally
giving a weighted average of the various delays. For narrow band signals, the
delays at a particular frequency band may be measured. An ensemble of such
measurements may be collected to develop a portrait of group delay.

If the signals of the three channels are highly mutually correlated (which is the
case if the signals are reconstructed well and free of distortions other than delay),
the “loop” delay will be approximately zero:

Delayl - Delay2 + Delay3 = 0, where

Delaylis Y toPbor Gto B
Delay2is Y to Pror Gto R
Delay3 is Pb to Pr or B to R

The more the loop delay deviates from zero, the less the three signals mutually
correlate. High loop delay corresponds to different types of signals among the
three channels, because of differences either in distortions or in the inherent
source signal (as in some live program material, for example). Loop delay
greater than 5ns will generate a warning if warnings are enabled.
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How Results are ~ The maximum cross-correlation of transitions is found between each pair of
Calculated  channels. The location of the maximum is the delay in time. Generally, one may
think of the calculation of the delay as the average match of transitions, weighted
by the amplitude of each transition.
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Measuring Color Bars

Signal Source

Interpreting Results

How Results are
Calculated

3-18

Measuring GBR color bars from a set-top-box can be used to verify the correct
colorimetry conversion. Likewise, conversion from 1080i/720p to 480p
colorimetry in YPbPr can be verified. The Color Bars measurement also can be
used to check individual channel gain. In addition, it can be used as a crude
check of linearity since severe clipping or other non-linear distortions will alter
the measurement results from the ideal.

You can use the matrix signal, or you can use a signal with all eight valid color
bars on the line. There is no requirement for the order of the bars except for the
bias that black will be searched after (to the right of) blue. Each of the bars
should be at least 1/24 of the active line time in duration.

The Color Bars measurement measures the amplitude level (relative to back
porch) of each of the 8 colors (white, yellow, cyan, green, magenta, red, blue,
black) for each active channel. Therefore, this measurement makes 8 measure-
ments on 3 channels for 24 total measurements. The software assumes Y is on
Channel 1, Pb is on Channel 2, and Pr is on Channel 3.

NOTE. Some signals intentionally reverse or change the order from the tradition-
al color bar test signal order. Since the bars are measured regardless of order, if
channel inputs are swapped, especially in the case of RGB, the resulting input
will consist of “valid” color levels for all eight bars, but the order will be
incorrect.

First the bars are identified using the relative amplitudes of the three channels
and the specification for the selected format and colorimetry.

The amplitudes are calculated using waveform averaged values within each
identified bar relative to back porch. Thus, it is important to ensure that the sync
signal is within the captured data window for valid measurements. For example,
if a manual set-up is performed, not only are all eight bars required on the
waveform display, but the entire horizontal blanking area to the right of the
signal being measured is also required in order to locate the sync signal and the
associated back porch.
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Measuring Multiburst

Signal Source

Interpreting Results

The Multiburst measurement is used to verify frequencies and corresponding
amplitudes of sinusoidal bursts. It can be used to verify the proper reconstruction
of a band-limited video signal across the frequency spectrum. For example, a
frequency roll-off (decrease in amplitude with increasing frequency) is seen with
video from an analog-to-digital converter that lacks a reconstruction filter with
sin(x)/x correction. In this example, quality is reduced by things like loss of
detail in the video or color shifts in details.

Deviations in frequency from the reference test signal frequency (for example, a
30 MHz burst is rendered as a 20 MHz burst) may indicate things such as format
change through frequency shift, frequency aliasing due to digital and/or analog
re-sampling, and/or frequency aliasing due to the lack of a proper reconstruction
filter.

The flag amplitude measurement can be used to verify the channel gain across a
wider frequency range than each burst. Burst amplitudes are measured relative to
the flag amplitude.

You can use the matrix signal, or you can use any multiburst signal with a
reference flag preceding the bursts. The more cycles present in each burst, the
more robust and generally more accurate the measurement will be. A burst with
less than 2 cycles is not recommended.

The frequencies are always displayed from lowest to highest regardless of the
order of burst frequencies in the multiburst signal. To avoid confusion regarding
the correspondence between the results burst numbering and the signal burst
ordering, a signal with increasing burst frequencies (from left to right) is
recommended.

For multiburst signals free of non-linear distortion and with increasing burst
frequencies, the “Frq(MHz)” column displays the fundamental frequency of burst
specified in each row. The “Amp(dB)” column has the magnitude of the
corresponding burst.

However, if non-linear distortion is present, interpreting results may be less
straight forward.

In many consumer set-top boxes, lack of a reconstruction filter (with out-of-band
rejection plus sin(x)/x correction) leads to roll-off in the fundamental frequency
component of the bursts even though the envelope of the bursts may be flat on
average. In this case, the amplitude results for the highest frequency may be low
by a few dB even though the waveform shows the same burst with peak-to-peak
amplitude closer to 0 dB. This indicates that the burst is no longer a pure
windowed sinusoid, but has other spectral content (at least one alias frequency in
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How Results are
Calculated

this example). If the extra spectral content is removed by filtering, the resulting
sinusoid will have the amplitude shown in the results.

Generally, if the signal has undergone processing without a required anti-alias
filter (as in re-sampling for format conversion, or signal reconstruction), each
burst may contain one or several frequency aliases. In such cases, burst
frequencies that increase with each burst of the input signal may contain burst
frequencies in nearly any order in the output of the device under test.

For example, in the 480p rendering of an ATSC 1080i multiburst signal, 5 MHz
is rescaled to 4.85 MHz, 10 MHz to 9.71, but 15 MHz, 20 MHz, 25 MHz, and
30 MHz become any number of frequencies (including 12.44 MHz, 7.58 MHz,
2.73 MHz, and 2.12 MHz respectively). These frequency aliases and respective
amplitudes are measured and displayed in order: 2.12 MHz, 2.73 MHz,

4.85 MHz, 7.58 MHz, 9.71 MHz, 12.44 MHz.

The six largest peaks are found in the spectrum of signal on the pedestal. These
frequencies are displayed in order from lowest to highest. For each of these
frequencies, the maximum magnitude of the cross-correlation between the signal
within the pedestal area and a windowed complex sinusoid is found. This gives
the amplitude.
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Measuring Noise

The unweighted noise within the nominal bandwidth of the video signal is
measured to ensure that the video quality is not reduced by random errors such
as those that cause “snow.”

Signal Source  You can use the matrix signal, or you can use any flat line or line pedestal signal.

Interpreting Results  As a rule of thumb, errors generally become visible when the signal-to-noise dB
measurement ranges in the low 40s. However, the degree of visibility depends on
many factors, including spectral distribution of the noise. In standard definition
television, noise weighting filters such as CCIR Recommendation (Rec) 576-2
unified weighting filter are used to weight the noise spectrum to better match the
visibility of noise in typical viewing conditions. The unified weighting filter has
been modified to exactly match the “visibility of noise characteristics” of 576-2
on the screen for each selected video format.

How Results are  After line tilt and other low frequency distortions are removed from the signal,
Calculated  all AC signal content is spectrally weighted by the selected filter, if any, and the
resulting RMS voltage is calculated along with the signal-to-noise ratio in dB
using a 700mV peak signal value.
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Measuring Non Linearity

This measurement is used to measure deviations from a straight line ramp test
signal. Deviations can be caused by such things as soft-limiting from analog
amplifiers and digital processing errors. Problems in linearity can reduce video
quality by, for example, reducing contrast at various average luminance levels,
creating color shifts.

Signal Source  You can use the matrix signal, or you can use either a ramp or step signal.
However, a ramp signal will give the best accuracy.

Interpreting Results  The measurement shows deviations from linear increase in the test signal as a
percentage of the largest increase per time found.

How Results are  In the case of steps, results are deviations in step amplitudes in the test signal as
Calculated  a percentage of the largest step found.

In the case of ramps, using six equal time intervals across the ramp, results are
deviations from linear increase in the test signal as a percentage of the largest
increase per time found.

3-22 VMS5000 Option HD Automatic Video Measurement Set User Manual



Detailed Measurement Information

Measuring Sync

This measurement is used to check synchronization signal timing and amplitude,
including the relative position of the start and end of active video (interpreted by
looking at front and back porch times).

Signal Source  You can use the matrix signal, or you can use a signal with signal amplitude
greater than 7.5% at the beginning and end of active video in order to measure
front porch and back porch times.

Interpreting Results  The amplitudes are measured relative to back porch.

Selecting either 1080 or 720 formats will display the tri-level sync results.
Selecting either 480, 576, or SXGA will display the bi-level sync results.

How Results are ~ The amplitudes are measured relative to back porch.

Calculated , , . . iy
The times are taken as the time between half amplitudes of adjacent transitions.

For example, “Neg. Sync Width” is the measured time between the half
amplitude of the falling or leading edge of negative sync and the half amplitude
of the rising or trailing edge of negative sync.

In the absence of sufficiently large (greater than 7.5%) video signal, the width of
front porch and back porch may not be found. In this case, the measurement of
the respective porch widths will not be valid.
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Appendix A: Specifications

All specifications are guaranteed unless labeled “typical.” Typical specifications
are provided for your convenience but are not guaranteed. To meet specifica-
tions, the following conditions must be met:

®m  The oscilloscope must have been calibrated in an ambient temperature
between 20 °C and 30 °C (68 °F and 86 °F).

®  The oscilloscope must be operating within the environmental limits listed in

Table A-10 on page A-16.

B The oscilloscope must be powered from a source that meets the specifica-
tions listed in Table A-8 on page A-15.

B The oscilloscope must have been operating continuously for at least 20
minutes within the specified operating temperature range.

B You must perform the Signal Path Compensation procedure after the
20-minute warm-up period. If the ambient temperature changes more than
5 °C (9 °F) you must restart the procedure. See Signal Path Compensation in
the Getting Started chapter of the TDS5000B Series Quick Start User

Manual.

Table A-1: Video measurement specifications

Characteristic Description
Color bar measurement accuracy | 2.0 mV £1.5 V% Measurement of all 8 bar
of reading levels, displayed in abso-
lute (mV) values. YPbPr or
RGB formats.
Noise measurement Range and Accuracy

Unweighted -20to -60 dB, +1 dB Noise measurement band-
(30 MHz measurement width selectable, 200 KHz
bandwidth) to 250 MHz. Trigger on

CH 4 required for measure-
-60 to -70 dB, +2 dB ments below -60 dB
(30 MHz measurement (30 MHz BW)
bandwidth) )

Weighted -20 to -60 dB, +2 dB Unified Weighting Filter.
Trigger on CH 4 required
for measurements below
-60 dB.

Noise floor Less than -76 dB, 30 MHz | Typical is less than -80 dB,

noise bandwidth 30 MHz noise bandwidth
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Table A-1: Video measurement specifications (Cont.)

Characteristic Description
Multiburst measurement Accuracy
Flag amplitude +2mV +1.5% of reading
1 MHZ to 10 MHz packets | +0.5 dB Measurement relative to
10 MHZ to 30 MHz packets | £0.75 dB reference flag amplitude
Frequency readout Multiburst packet frequency
is measured and displayed.
Non-linearity measurement 1.5% Non-linearity measurement
accuracy using a ramp test signal.
Incremental linearity re-
ported over five equally
spaced intervals, as well as
an overall linearity figure for
each channel.
Sync measurement Accuracy
Sync amplitude =2mV =1.5% of reading Blanking interval measure-
Svnc timin “51s ments, including sync am-
ync timing = plitude, width, and rise
Rise and Fall time +5ns time.
Channel delay CH1toCH2,CH1to CH3,CH21t0o CH 3;
readouts in ns.
Range Accuracy
Measurement =35 ns +5ns
Delay match error Less than 1 ns Any two channels

Table A-2: Channel input and vertical specifications

Characteristic Description

Input coupling AC, DC, and GND
Input channels Four identical channels
Input impedance selection 50 Qor 1 MQ

Bandwidth limited to 500 MHz, 1 M<2 selected

Input impedance, DC coupled 50 Q +2.5%, typical

1 MQ =1.0% in parallel with 18 pF +2 pF
VSWR <1.5:1, typical, from DC to 1 GHz

Maximum voltage at input BNC AC, DC, or GND coupled
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Table A-2: Channel input and vertical specifications (Cont.)

Characteristic

Description

1 MQ

150 Vs CAT I, and <400 peak

For steady state sinusoidal waveforms, derate at
20 dB/decade above 200 kHz to 9 Vgys at =3 MHz

50 Q

<1 Vrms for settings below 100mV/div

<5 Vrms for 100 mV/div settings and above

Differential delay, DC 50 Q input

<100 ps between any two channels with DC input
coupling and the same V/div scale settings at or above
10 mV/div

Deskew range, typical

+75.0 ns

Channel-to-channel crosstalk

=100:1 at <100 MHz

=30:1 at >100 MHz up to the rated bandwidth for any two
channels with equal V/div settings

Digitizers

8-bit resolution

Four separate digitizers, each channel sampled
simultaneously

Sensitivity range

Fine adjustment available with <1% resolution

1 MQ

1 mV/div to 10 V/div, in a 1-2-5 sequence

50 €2

1 mV/div to 1 V/div, in a 1-2-5 sequence

Analog bandwidth

SCALE range Bandwidth
1 mV/div to 1.99 mV/div DC to 175 MHz
2 mV/div to 1 V/div DCto1GHz

DC 50 Q coupling; bandwidth limit set to Full; operating
ambient <30 °C; derated by 5 MHz/°C above 30 °C

Analog bandwidth selections

20 MHz, 150 MHz, or Full
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Table A-2: Channel input and vertical specifications (Cont.)

Characteristic

Description

Analog Bandwidth Limit

Low frequency, AC coupled

50 Q: <200 kHz

1 MQ: <10 Hz, reduced by a factor of ten when using a

10X probe

High frequency, typical

20 MHz: with 20 MHz bandwidth limit turned on

150 MHz: with 150 MHz bandwidth limit turned on

Calculated rise time, typical

DC 50 Q coupling, bandwidth limit set to Full

SCALE range Rise time
1 mV/div to 1.99 mV/div 2.29ns
2 mV/div to 1 V/div 300 ps

Step response settling errors,
typical

Bandwidth limit set to Full

SCALE range

Settling error at time after
step

=2 V step amplitude

1 mV/div to 99.5 mV/div

20 ns: <0.5%

100 ns: <0.2%

20 ms: <0.1%

=20 V step amplitude

100 mV/div to 1.0 V/div

20 ns: <1.0%

100 ns: <0.5%

20 ms: <0.2%

=200 V step amplitude

1.01 V/div to 10 V/div

20 ns: <1.0%

100 ns: <0.5%

20 ms: <0.2%

Position range

+5 divisions

Peak Detect or Envelope Mode
Pulse Response

Capture of single event pulses

Offset range

1 M coupling

Number of channels Minimum pulse width
1or2 400 ps

3ord 800 ps
User-adjustable input offset voltages

SCALE range Offset range

1 mV/div to 99.5 mV/div =1V

100 mV/div to 1 V/div =10V

1.01 V/div to 10 V/div =100V
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Table A-2: Channel input and vertical specifications (Cont.)

Characteristic Description
50 Q coupling 1 mV/div to 50 mV/div 0.5V
50.5 mV/div to 99.5 mV/div | +0.25V
100 mV/div to 500 mV/div |5V
505 mV/div to 1 V/div 25V
Offset accuracy SCALE range Offset range

1 mV/div to 9.95 mV/div

£[(0.2% X | net offset |) +
1.5mV + (0.1 div X V/div
setting)]

10 mV/div to 99.5 mV/div

+[(0.35% x| net offset |) +
1.5mV + (0.1 div X V/div
setting)]

100 mV/div to 1.0 V/div

+[(0.35% x| net offset |) +
15mV + (0.1 div X V/div
setting)]

1.01 V/div to 10 V/div

Temperatures >40 °C

+[(0.25% x| net offset |) +
150 mV + (0.1 div x V/div
setting]

+[(0.75% x| net offset |) +
150 mV + (0.1 div x V/div
setting)]

where, net offset = offset - (position X volts/division)
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Table A-2: Channel input and vertical specifications (Cont.)

Characteristic

Description

DC gain accuracy, Sample or

+3% +1.0% X |net offset /offset range| for 2 mV/div -

Average acquisition mode 3.98 mV/div
DC voltage measurement accuracy | Measurement type DC accuracy (in volts)
Sample acquisition mode, | Any sample 2 mV/div - 3.98 mV/div

typical

£[(1.5% + 3.0% X |net
offset /offset range) X
|reading - net offset| +
offset accuracy + 0.13 div
X V[div setting + 0.6 mV]

Delta voltage measurement
between any two points
acquired under the same
setup and ambient condi-
tions

2 mV/div - 3.98 mV/div
+[1.5% +3.0% X |net
offset /offset range| x
|reading - net offset| + 0.26
div X V/div setting
+1.2mV]

Where, net offset = offset - (position X volts/division)

»~ Average acquisition
mode

Average of =16 waveforms

2 mV/div - 3.98 mV/div
+[1.5% +3.0% X

|net offset /offset range| x
|reading - net offset| +
offset accuracy + 0.06 div
X V/div]

Delta voltage measurement
between any two averages
of =16 waveforms acquired
under the same setup and
ambient conditions

2 mV/div - 3.98 mV/div
+[1.5% +3.0% X |net
offset /offset range| x
|reading - net offset|
+0.1div X V/div
+0.3mV]

Where, net offset = offset - (position X volts/division)

Nonlinearity, typical

<1 LSB differential, <1 LSB integral, independently

based

Effective bits, typical

Sine wave input at the indicated fre-

quency and pk-pk amplitude,
50 mV/div and 25 °C

Signal and input conditions

Signal and input conditions

1 MHz, 9.2 div, 5 GS/s
sample rate, Sample
acquisition mode

6.6 bits

1 MHz, 9.2 div, 10 MS/s 9.0 bits
sample rate, HiRes acquisi-

tion mode

1 GHz, 6.5 div, 5 GS/s 4.7 bits

sample rate, Sample
acquisition mode
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Table A- 3: Horizontal and acquisition system specifications

Characteristic

Description

Acquisition modes

Sample, Peak detect, Hi Res, Average, and Envelope

Fast acquisition rate

Up to 100,000 waveforms-per-second with Fast
Acquisition mode on

Up to 130 waveforms-per-second with Fast Acquisition
mode off

Minimum record length

500 points

Maximum record length

Depends on number of active channels and amount of
memory installed

Standard

2,000,000 points (3 or 4 channels)
4,000,000 points (2 channels)
8,000,000 points (1 channel)

Option 3M installed

4,000,000 points (3 or 4 channels)
8,000,000 points (2 channels)
16,000,000 points (1 channel)

Sample rate range, real-time Number acquired channels | Sample rate range
1 1.25 S/sto 5 GS/s
2 1.25 §/s t0 2.5 GS/s
3ord 1.25 S/s t0 1.25 GS/s
Equivalent-time sample rate or 2.5 GS/s to 250 GS/s

interpolated waveform rate range

Listed values depend on the number of channels in use,
horizontal scale, and resolution settings.

Equivalent-time acquisition can be enabled or disabled.
When disabled, waveforms are interpolated at the fastest
time base settings.

Secondsj/division range

(s/div x 10) t0 1,000 s

Horizontal delay range

16 nsto 250 s

Long term sample rate and delay
time accuracy

=15 ppm over any =1 ms interval

RMS aperture uncertainty, typical

=<[3ps + (0.1 ppm X record duration)] for real-time or
interpolated records with a duration =1 minute
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Table A- 3: Horizontal and acquisition system specifications (Cont.)

Characteristic

Description

Delta time measurement
accuracy

For a single channel, with signal amplitude > 5 div,
reference level set at 50%, interpolation set to sin(x)/x,
volts/division set to = 5 mV/div, with (displayed
risetime)/(sample interval) ratio between 1.4 and 4, where
sample interval = 1/(real-time sample rate)

Conditions

Accuracy

Single shot signal, Sample,
or Hi Res acquisition mode,
Full bandwidth

= (15ppm X | reading | +
0.3 sample intervals)

Average acquisition mode,
=100 averages, Full band-
width

= (15ppm X | reading | +
20 ps)

Table A-4: Trigger specifications

Characteristic Description

Auxiliary trigger input resistance, =1.5kQ

typical

Maximum trigger input voltage, +20 V (DC or peak AC)

typical

Edge trigger sensitivity, Main and | Trigger Source Sensitivity

Delayed trigger

Any channel, DC coupled

0.35 div from DC to
50 MHz, increasing to 1 div
at1GHz

Auxiliary input

400 mV from DC to
50 MHz, increasing to
750 mV at 100 MHz

Edge trigger sensitivity, typical

All sources, for vertical scale
<1 V/div

settings =10 mV/div and

Trigger coupling Sensitivity

NOISE REJ 3 X the DC-coupled limits

AC Same as DC-coupled limits
for frequencies =60 Hz;
attenuates signals <60 Hz

HF REJ 1.5 X the DC-coupled

limits from DC to 30 kHz;

attenuates signals >30 kHz
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Table A-4: Trigger specifications (Cont.)

Characteristic

Description

LF REJ 1.5 X the DC-coupled
limits for frequencies =80
kHz; attenuates signals
<80 kHz

Advanced trigger sensitivity, typical

For all trigger types except Edge, with vertical scale
settings =10 mV/div and <1 V/div

1.0 div from DC to 500 MHz

Event count sensitivity, typical

For sequential trigger delayed by events, with vertical
scale settings =10 mV/div and <1 V/div

1.0 div, from DC to 500 MHz

Video trigger sensitivity, typical

For delayed and main triggers, with vertical scale settings
=10 mV/div and <1 V/div

Any channel 0.6 to 2.5 divisions of video
sync tip

Video Trigger Format

Triggers from negative sync composite video, field 1 or
field 2 for interlaced systems, any field, specific line, or
any line for interlaced or noninterlaced systems

Supported systems include NTSC, PAL, SECAM, and
analog HDTV

Trigger level or threshold range

Trigger Source Sensitivity

Any channel +10 divisions from center of
screen

Auxiliary input =8V

Line Fixed at zero volts
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Table A-4: Trigger specifications (Cont.)

Characteristic

Description

Trigger level or threshold accuracy,

typical

Edge trigger, DC coupling, for
times <20 ns

signals having rise and fall

Trigger Source Accuracy

Any channel £ [(2% x| setting - net
offset |) + (0.3 div X volts/
div setting) + offset accu-
racy]

Auxiliary Not calibrated or specified

Where, net offset = offset - (position X volts/division)

Set level to 50% function, typical

Operates with signals =30 Hz

Trigger position error, typical

Edge trigger, DC coupling, for

signals having a slew rate

at the trigger point of <0.5 div/ns

Acquisition mode

Error

Sample, Average

+ (1 displayed pt + 1 ns)

Envelope + (2 displayed pts + 1 ns)
Trigger jitter, typical o0 =8ps RMS
B Event (Delayed) trigger Trigger After Time Trigger on n' Event
Range Delay time = 16 ns to Event count = 1 to 107
250 s
Minimum time between arm | 2 ns from the end of the 2 ns between the A trigger
(A Event) and trigger time period to the B trigger | event and the first B trigger
(B Event), typical event event

Minimum pulse width,
typical

B event width =1 ns

Maximum frequency, typical

B event frequency

=500 MHz
Advanced trigger timing For vertical scale settings =10 mV/div and <1 V/div
Minimum recognizable Minimum rearm time to
event width or time recognize next event
Glitch type Minimum glitch width = 1 ns | 2 ns + 5% of glitch width
setting
Runt or window type Minimum runt width=2ns |2ns

Runt or window type (time
qualified)

Minimum runt width = 2 ns

8.5 ns + 5% of runt width
setting

Runt or window type (logic
qualified)

Minimum runt width = 2 ns

8.5 ns + 5% of runt width
setting
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Table A-4: Trigger specifications (Cont.)

Characteristic Description

Width type Minimum difference 2 ns + 5% of upper limit
between upper and lower | setting
limits = 1 ns

Timeout type Minimum timeout time = 2 ns + 5% of timeout set-
1ns ting

Transition type Minimum transition time = | 8.5 ns + 5% of transition
600 ps time setting

Pattern type, typical Minimum time the patternis | 1 ns
true=1ns

Logic Not applicable 1ns

Events Delay

1 ns (single channel)

Not applicable

State type, typical

Minimum true time before
clock edge = 1 ns

Minimum true time after
clock edge = 1 ns

1ns

Setup/Hold type, typical

Minimum clock pulse width
from active edge to inactive
edge

Minimum clock pulse width
from inactive edge to active
edge

3 ns + hold time setting

2ns

Setup and Hold parameters

Limits

Setup time (time from data
transition to clock edge)

-100 ns minimum
+100 ns maximum

Hold time (time from clock
edge to data transition)

-1 ns minimum
+102 ns maximum

Setup time + Hold time
(algebraic sum of the two
settings)

+2 NS minimum
+202 ns maximum
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Table A-4: Trigger specifications (Cont.)

Characteristic Description
Advanced trigger timer ranges Limits
Glitch type instols
Runt or window type, wider |1nsto1s
than
Runt or window type, time |1 nsto1s
qualified
Width type 1nsto1s
Timeout type 1nstols
Transition type instols
Pattern type 1nsto1s
Setup/Hold type Setup and Hold timers Limits

Setup time (time from data | -100 ns to +100 ns
transition to clock edge)

Hold time (time from clock | -1 nsto +100 ns
edge to data transition)

Setup time + Hold time +2 ns to +200 ns
(algebraic sum of the two
settings)

Advanced trigger timer accuracy For Glitch, Timeout, or Width types

Time range Accuracy
1 ns to 500 ns +(20% of setting + 0.5 ns)
520nsto1s +(0.01% of setting +
100 ns)
Trigger holdoff range 1.15 zus to 12 s, minimum resolution is 8 us for settings
<1.2ms
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Table A- 5: Display specifications

Characteristic Description

Display type 264 mm (10.4 in) diagonal, liquid crystal active-matrix
color display
Width: 211.2 mm (8.3 in)
Length:: 158.4 mm (6.2 in)

Display resolution 640 horizontal x 480 vertical pixels

Pixel pitch 0.33 mm horizontal, 0.33 mm vertical

Contrast ratio, typical

150:1

Response time, typical

50 ms, black to white

Display refresh rate

59.94 frames per second

Displayed intensity levels

Supports Windows SVGA high-color mode
(16-bit or 24-bit)

Table A- 6: Input/output port specifications

Characteristic

Probe Compensator Output

Description

Front-panel terminals

Output voltage Frequency
1.0 V (from base to top) 1 kHz +5%

+1.0% into a = 10 k<2 load

Analog Signal Output

Rear-panel BNC connector, provides a buffered version of
the signal that is attached to the channel 3 signal input

50 mV/div £20% into a 1 M<2 load
25 mV/div =20% into a 50 Q2 load

Bandwidth, typical

100 MHz into a 50 2 load

Auxiliary Output levels

Rear-panel BNC connector, provides a TTL-compatible,
negative-polarity pulse for each A or B trigger (selectable)

Vout high Vout low (true)

=2.5 V into open circuit, <0.7 V with =4 mA sink,
=1.0 Vinto 50 Q load <0.25 V into 50 Q load

Auxiliary Output pulse width, typical

Pulse width varies, 1 us minimum

External Reference Input

Rear-panel BNC connector

9.8 MHz to 10.2 MHz

200 mVp_p to7 Vp_p

< 1.5 kQ in series with ~10 nF DC blocking capacitor

Side-panel I/0 ports

Ports located on the side panel

VMS5000 Option HD Automatic Video Measurement Set User Manual
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Table A-6: Input/output port specifications (Cont.)

Characteristic Description

Parallel port (IEEE 1284) DB-25 connector, supports the following modes:
Standard, output only

Bidirectional, PS-2 compatible

Bidirectional Enhanced Parallel Port (IEEE 1284
standard, mode 1 or mode 2, v 1.7)

Bidirectional High-speed Extended Capabilities Port

Audio ports Miniature phone jacks for stereo microphone input and
stereo line output

USB port (2) Allows connection of USB keyboard/mouse and or other
devices while scope power is on
Supports USB 2.0 protocol

Keyboard port PS-2 compatible, oscilloscope power must be off to make
connection

Mouse port PS-2 compatible, oscilloscope power must be off to make
connection

LAN port RJ-45 connector, supports 10 base-T and 100 base-T

Serial port (COM1) DB-9 connector, uses NS16C550-compatible UARTS,

transfer speeds up to 115.2 kb/s

SVGA video port Upper video port, DB-15 female connector, connect a
second monitor to use dual-monitor display mode,
supports Basic requirements of PC99 specifications

GPIB port IEEE 488.2 standard interface

Scope VGA video port Lower video port, DB-15 female connector, 31.6 kHz
sync, EIA RS-343A compliant, connect to show the
oscilloscope display, including live waveforms, on an
external monitor

Table A-7: Data storage specifications

Characteristic Description

CD-ROM Side-panel CD-R/W drive; reads CD/CD-ROM, CD-R, and
CD-R/W disks
24X read speed; 24X write speed

Floppy disk Front-panel 3.5 in USB floppy disk drive, 1.44 MB
capacity

Hard disk Standard internal hard disk capacity: 80 GB
External hard disk capacity: refer to added options
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Table A- 8: Power source specifications

Characteristic Description
Source voltage and frequency 100 to 240 Vgys +10%, 47 Hz to 63 Hz
Power consumption <220 Watts

Fuse rating

Internal to power supply; not serviceable by user

Nonvolatile memory retention

CMOS settings stored for a period of 3 years without
instrument connection to power mains

Calibration settings and error log entries stored for
1 million cycles or 20 years

Overvoltage Category

Overvoltage Category Il (as defined in IEC61010-1/A2)

Table A-9: Mechanical specifications

Characteristic

Description

Weight

Benchtop configuration

24.75 Ibs (10.2 kg) oscilloscope only
56.5 Ibs (25.6 kg) when packaged for domestic shipment

Rackmount kit

5 Ibs (2.3 kg) rackmount conversion kit
8 Ibs (3.6 kg) kit packaged for domestic shipment

Dimensions

Benchtop configuration

Height: 14.2 in (360.7 mm)

Height:, feet extended:14.25 in (362 mm)
Width: 17.6 in (447 mm)

Depth: 11.35 in (288.3 mm)

Rackmount configuration

(Option 1R)

Height: 10.5 in (267 mm)
Width: 19 in (483 mm)
Depth: 9.1 in (231 mm)

Cooling

Fan-forced air circulation with no air filter

Required clearances

Top 0in (0 mm)

Bottom 0.25 in minimum or
0 in (0 mm) when standing
on the feet

Left side 3in (76 mm)

Right side 0in[5in (126 mm) required
to access CD-ROM]

Front 0in (0 mm)

Rear 0in (0 mm)
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Table A-9: Mechanical specifications (Cont.)

Characteristic

Description

Construction material

Chassis parts constructed of aluminum alloy; front-panel
constructed of plastic laminate; circuit boards constructed
of glass laminate; outer shell molded and textured from a
polycarbonate/ABS blend

Table A-10: Environmental specifications

Characteristic

Description

Temperature
Operating

+5 °C to +45 °C (+41 °F to +113 °F)

Nonoperating

-20 °C to +60 °C (-4 °F to +140 °F)

Humidity
Operating

20% to 80% relative humidity with a maximum wet bulb
temperature of +29 °C (84.2 °F) at or below +45 °C
(113 °F), noncondensing

Upper limit derated to 30% relative humidity at +45 °C
(113 °F)

Nonoperating

With no diskette in floppy disk drive

5% to 90% relative humidity with a maximum wet bulb
temperature of +29 °C (84.2 °F) at or below +60 °C
(+140 °F), noncondensing

Upper limit derated to 20% relative humidity at +60 °C
(+140 °F)

Altitude
Operating

10,000 ft (3,048 m)

Nonoperating

40,000 ft (12, 190 m)

Random vibration

Operating

0.1 grMimess from 5 Hz to 500 Hz, 10 minutes on each
axis

Nonoperating

2.0 grms from 5 Hz to 500 Hz, 10 minutes on each axis

Shock, nonoperating

30 g (11 ms half-sine wave) or less
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Table A-11: Certifications and compliances

Category Standards or description
EC Declaration of Conformity - Meets intent of Directive 89/336/EEC for Electromagnetic Compatibility. Compliance was
EMC demonstrated to the following specifications as listed in the Official Journal of the European Union:
EN 61326 Emissions 1:3:4  Class A Radiated and Conducted Emissions
EN 61326 Immunity -4
IEC 61000-4-2 Electrostatic Discharge Immunity
+4 kV contact discharge, +8 kV air discharge
IEC 61000-4-3 RF field immunity
3V/m, 80 MHz to 1 GHz,
80% amplitude modulated with a 1 kHz sinewave 2
IEC 61000-4-4 Electrical Fast Transient/Burst Immunity
1 kV on AC mains, 500 V on I/O
IEC 61000-4-5  AC Surge Immunity
500 V differential mode, 1 kV common mode
IEC 61000-4-6 RF Conducted Immunity
3V, 150 kHz to 80 MHz, amplitude modulated with a
1 kHz sinewave 2
IEC 61000-4-11  AC Mains Voltage Dips and Interruption Immunity
100% reduction for one cycle
EN 61000-3-2 Power Harmonic Current Emissions
EN 61000-3-3 Voltage Changes, Fluctuations, and Flicker
1 Use low-EMI shielded interconnect cables, equivalent to the following Tektronix cables:
GPIB cable: 012-0991-01, 012-0991-02, or 012-0991-03.
RS-232 cable: 012-1213-00 or CA part number 0294-9.
Centronics Cable: 012-1214-00 or LCOM part number CTL3VGAMM-5 VGA Cable.
2 Under theses conditions, the specifications are amended as follows:
1 mV/division to 1 V/division: <0.2 division waveform displacement or <0.4 division increase
in peak-to-peak noise.
3 Radiated emissions may exceed the levels specified in EN 61326 when this instrument is
connected to a test object.
4 Tested in accordance with EN 61326 Annex D.
FCC Radiated and conducted emissions do not exceed the levels specified in FCC47 CFR, Part 15,
Subpart B, for Class A equipment.
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Table A-11: Certifications and compliances (cont.)

Category

Standards or description

EC Declaration of Conformity -
Low Voltage

Compliance was demonstrated to the following specification as listed in the Official Journal of the
European Union:

Low Voltage Directive 73/23/EEC, amended by 93/68/EEC

EN 61010-1/A2:1995 Safety requirements for electrical equipment for measurement

control and laboratory use.

U.S. Nationally Recognized
Testing Laboratory Listing

UL3111-1, First Edition Standard for electrical measuring and test equipment.

Canadian Cettification

CAN/CSA C22.2,
No. 1010.1-92

Safety requirements for electrical equipment for measurement,
control, and laboratory use.

Additional Compliance

IEC61010-1/A2 Safety requirements for electrical equipment for measurement,

control, and laboratory use.

Installation (Overvoltage)
Category

Terminals on this product may have different installation (overvoltage) category designations. The
installation categories are:

CAT Il Distribution-level mains (usually permanently connected). Equipment at this level is
typically in a fixed industrial location.

CAT Il Local-level mains (wall sockets). Equipment at this level includes appliances, portable
tools, and similar products. Equipment is usually cord-connected.

CAT |  Secondary (signal level) or battery operated circuits of electronic equipment.

Pollution Degree

A measure of the contaminates that could occur in the environment around and within a product.
Typically the internal environment inside a product is considered to be the same as the external.
Products should be used only in the environment for which they are rated.

Pollution Degree 2 Normally only dry, nonconductive pollution occurs. Occasionally a
temporary conductivity that is caused by condensation must be
expected. This location is a typical office/home environment.
Temporary condensation occurs only when the product is out of

service.

Safety Certification Compliance

Equipment Type

Test and measuring

Safety Class

Class 1 (as defined in IEC 61010-1/A2) - grounded product

Pollution Degree

Pollution Degree 2 as defined in IEC 61010-1/A2

Rated for indoor use only

A-18
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Appendix B: Performance Verification

This Performance Verification checks that the VM5000 Option HD meets its
video measurement specifications (Table A-1 in Appendix A, Specifications).

Prerequisites
®m  The test signal generator and VM5000 Option HD instrument require a
minimum 20 minute warm-up time before doing any performance verifica-
tion tests.
®  Perform the VM5000 Option HD instrument internal system diagnostics in
the Utilities menu. The instrument must pass the diagnostics before you can
verify performance.
®  Perform the VM5000 Option HD instrument Signal Path Calibration (SPC)
procedure. The instrument must pass the SPC before you can verity
performance.
Required Equipment
Table B- 1: Required test equipment
Item number and
description Minimum requirements Example Purpose
HD CAV Television Test Tektronix TG700 with AWVG? | All tests
Signal generator module
(one required)
Digital Multimeter 5-1/2 digits, better than 0.1% DC Fluke 8842A or AWVG? signal output test
(one required) accuracy 0-1V Fluke model 45
75 Q BNC Cable 42 inches (106.68 cm) long Tektronix part number All tests
(four required) 012-0074-00
75 Q precision BNC 0.025% Accuracy Tektronix part number All tests
terminations 011-0102-03
(four required)
Connector, Dual-Banana Female BNC-to-dual banana Tektronix part number AWVG7 signal output test
(one required) 103-0090-00
Connector, BNC ‘T’ Male BNC-to-dual female BNC Tektronix part number All tests
(four required) 103-0030-00
Coupler, Dual-Input Female BNC-to-dual male BNC Tektronix part number Channel delay match test
BNC ‘T’ cable assembly (one 067-0525-02
required)
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VM5000 Option HD Tests

Determine the AWVG7  This procedure determines the test signal generator output signal amplitude. You
Signal Output Amplitude  will need this value for calculating measurements. This procedure assumes you
are using a Tektronix TG700 test signal generator with an AWVG7 module. If
you are using a different test signal source, modify the steps according to your
particular setup.

Equipment HD CAV Television Test Signal generator (Tektronix TG700 with
required AWVG7 module)

Digital multimeter

75 Q BNC Cable (1)

75 Q precision BNC terminations (1)
Connector, Dual-Banana (1)
Connector, BNC ‘T’ (1)

Prerequisites The test signal generator and multimeter must warm up for at least 20
minutes prior to doing this test.

NOTE. Make sure that the AWVG7 generator module and the multimeter have
had a warm up period of at least 20 minutes.

1. Connect the digital multimeter to the test signal source. Refer to Figure B-1
while doing the following steps:

a. Connect one end of a 75 € BNC cable to the upper CH 1 connector on
the AWVG7 generator module.

b. Connect the other cable end to the digital multimeter with a BNC ‘T’
connector, 75 € precision termination, and BNC female-to-dual banana
adapter.
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TG700 with — BNC to Dual banana

AWVG7 module

75 Q Termination

O

CH3

O

CH2

O

CHf
BNC “T”
connector

Figure B-1: Signal output amplitude test hookup

2. On the TG700, press the MODULE, FORMAT, and FRONT PANEL
ENABLE buttons simultaneously, and then release the MODULE and
FORMAT buttons. Continue to hold the FRONT PANEL ENABLE button
to display Factory Startup Mode.

3. Enable the DAC Gain (GBR) : 0 mV calibration signal as follows:
a. Press the MODULE button to display the AWVG7 main menu.
b. Press the up or down arrow button to select CALIBRATION.
c. Press the left or right arrow button to select DAC Gain (GBR).
d. Press the ENTER button.
e. Press the left or right arrow button to select 0 mV.
f. Press the ENTER button.
4. Enter the digital multimeter reading in Table B-2, row DCO0, column CH1.

5. Move the BNC cable from the upper CH 1 connector to the upper CH 2
connector on the AWVG7 generator module.

6. Enter the digital multimeter reading in Table B-2, row DCO0, column CH 2.

7. Move the BNC cable from the upper CH 2 connector to the upper CH 3
connector on the AWVG7 generator module.

8. Enter the digital multimeter reading in Table B-2, row DCO0, column CH 3.

9. On the TG700, press the left or right arrow button to select 700.397 mV.
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B-4

10

11.

12.

13.

14.

15.

16.

. Press the ENTER button.

Enter the digital multimeter reading in Table B-2, row DC700, column
CH 3.

Move the BNC cable from the upper CH 3 connector to the upper CH 2
connector on the AWVG7 generator module.

Enter the digital multimeter reading in Table B-2, row DC700, column
CH 2.

Move the BNC cable from the upper CH 2 connector to the upper CH 1
connector on the AWVG7 generator module.

Enter the digital multimeter reading in Table B-2, row DC700, column
CH 1.

Subtract the DCO values from the DC700 values, for each of the three
channels in Table B-2. The resulting three numbers are the Blanking-to-
White levels for each channel.

Table B-2: Measured blanking to white levels

CH1 CH2 CH3

DC700 (measured)

DCO (measured)

Blanking-to-white level
(DC700 minus DCO)
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Check Absolute  This test verifies the measurement amplitude accuracy of the three video input
Amplitude Measurement  channels (CH 1, CH 2, CH 3) and digitizers. This checks the accuracy specifica-
Accuracy tion for the Color Bars measurement, Multiburst Flag amplitude, and Sync
Amplitude. The accuracy specification for all three is £2mV +£1.5% of reading.

Equipment HD CAV Television Test Signal generator (Tektronix TG700 with
required AWVG7 module)

75 Q BNC cables (4)
75 Q precision BNC terminations (4)
Connector, BNC ‘T’ (4)

Prerequisites The test signal generator must warm up for at least 20 minutes prior to
doing this test. You must have completed the procedure Determine the
AWVG? Signal Outlet Amplitude on page B-2.

1. Connect the instrument to the test signal source. Refer to Figure B-2 while
doing the following steps:

a. Connect a 75 Q BNC cables to each of the upper CH1, CH2, and CH3
AWVGT7 outputs.

b. Connect the other end of each cable to a BNC “T’ connector and a
precision 75 €2 termination.

c. Connect the BNC ‘T’ connector to the VM5000 Option HD, so that the
cable from the AWVG7 CH1 output goes to the VM5000 Option HD
CH1 input.

d. Connect the CH2 cable to the VM5000 Option HD CH2 input and the
CH3 cable to the VM5000 Option HD CH3 input.
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B-6

VM5000 Option HD

TG700 with —— 75 Q Termination
AWVG7 module N
Ca\ L ©| <J— BNC “T” connector
O 10 U cH1| cHz | cHa | cHa J
CH3 | cH2 | cHi

Figure B-2: Amplitude accuracy test hookup

e. Connect a fourth 75 € BNC cable to the lower AWVG7 CH1 output.

f. Connect the other end of this cable to a BNC ‘T’ connector and a 75 Q
termination.

g. Connect the BNC ‘T’ connector to the VM5000 Option HD CH4 input.

2. On the TG700, press the MODULE, FORMAT, and FRONT PANEL
ENABLE buttons simultaneously to return the generator to normal operating
mode.

3. After it is finished loading, press MODULE repeatedly to display AWVGT7.
4. Press FORMAT repeatedly to display 1080 59i GBR.

W

Press ENTER.

NOTE. Press and hold the FRONT PANEL ENABLE button to unlock the front
panel.

6. Press COLOR BAR repeatedly to display 100% Color Bars.

7. Start the VM5000 Option HD application (File > Applications >
VMS000HD). Wait for the window to open after selecting VMS5000HD.

8. Select File > Recall Default.

9. Select Configuration > Format, and select RGB Color Space.
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10. Select Configuration > Operation, and select Channel 4 as the trigger.
Uncheck (turn off) All Measurement Warnings.

11. Select the VM5000HD Run button. The color bar measurement results table
should appear with continuously updated measurements.

12. In the Color bar measurements window, change the Averages setting to 64.
13. Record the VM5000HD measurement value for the white bar measurement,

for each of the three channels, in row 4 of Table B-3.

Table B-3: White bar measurement

CH1 (V/G) CH 2 (Pb/B) CH 3 (PrR)

AWVG? Blanking-to-White level
(DC700-DCO) (from Table B-2)

Lower white limit value (equation 1)

Upper white limit value (equation 2)

White measurement

Equation 1: Lower White limit value = (DC700-DC0) X (0.985) - 2 mV

Equation 2: Upper White limit value = (DC700-DC0) X (1.015) + 2 mV

14. Calculate the instrument white bar measurement as follows:

a. Copy the AWVGT7 Blanking-to-White level values (from Table B-2, row
3) for each channel in row 1 of Table B-3.

b. For each channel, calculate the Lower VM5000HD white limit, using
equation 1, and enter the values in row 2, Table B-3.

c. For each channel, calculate the Upper VM5000HD white limit, using
equation 2, and enter the values in row 3, Table B-3.

15. Check that the VM5000HD white measurement (row 4) falls between the
Lower (Line 2) and Upper (Line 3) limit values, for all three channels.

Table B-4 is an example of typical measurements and the calculation results.
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Table B-4: Example white bar measurement values

CH 1 (Y/G) CH 2 (Pb/B) CH 3 (Pr/R)
AWVG7 Blanking-to-White level 700.05 mV 700.00 mV 701.04 mV
(DC700-DCO) (from Table B-2)
Lower white limit value (equation 1) | 687.55 mV 687.50 mV 688.52 mV
Upper white limit value (equation2) | 712.55 mV 712.50 mV 713.56 mV
White measurement 696.55 mV 700.25 mV 695.01 mV

Equation 1: Lower White limit value = (DC700-DC0) X (0.985) - 2 mV

Equation 2: Upper White limit value = (DC700-DC0) X (1.015) + 2 mV

The calculated VM5000HD white measurements in row 4 are between the
LOWER and UPPER limit values (rows 2 and 3), so the measurements are
within specification for all channels.

B-8 VM5000 Option HD Automatic Video Measurement Set User Manual



Appendix B: Performance Verification

Check Frequency  This test verifies the frequency response accuracy of the three VM5000 Option
Response Measurement  HD video input channels (CH 1, CH 2, CH 3) and digitizers. This directly
Accuracy checks the Multiburst measurement accuracy, and indirectly the Noise measure-
ment up through 30 MHz. The Multiburst accuracy specification is +£0.5dB up
through 10MHz, and +0.75dB from 10 to 30 MHz.

Equipment HD CAV Television Test Signal generator (Tektronix TG700 with
required AWVG7 module)
75 Q BNC cables (4)

75 Q precision BNC terminations (4)
Connector, BNC ‘T’ (4)

Prerequisites The test signal generator must warm up for at least 20 minutes prior to

doing this test.

NOTE. The AWVG7 must meets its frequency response specification of
+1%(0.09dB) to 20 MHz, +2%(0.17dB) to 28 MHz, and £3%(0.26dB) to

30 MHz. If you are uncertain about the test signal generator calibration status,
perform the AWVG7 frequency response performance verification described in
the AWVGT7 Service Manual.

1. Connect the instrument to the test signal source. Refer to Figure B-3 while
doing the following steps:

a.

Connect 75 € BNC cables to the upper CH1, CH2, and CH3 AWVG7
outputs.

Connect the other end of each cable to a BNC T connector and a 75
termination.

Connect the BNC T connector to the VM5000 Option HD, so that the
cable from the AWVG7 CH1 output goes to the VM5000 Option HD
CH1 input.

Connect the CH2 cable to the VM5000 Option HD CH2 input and the
CH3 cable to the VM5000 Option HD CH3 input.

Connect a fourth 75 €2 BNC cable to the lower AWVG7 CH1 output.

Connect the other end of this cable to a BNC T connector and a 75 Q2
termination.

Connect the BNC T connector to the VM5000 Option HD CH4 input.
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B-10

VM5000 Option HD

TG700 with —— 75 Q Termination
AWVG7 module N
o~ { ©)! <—J BNC “T” connector
o100 U cHi | cHz2 | cHs | cHa J
cH3 | cH2 | cHi

Figure B-3: Frequency accuracy test hookup

On the TG700, press Module repeatedly to display AWVGT.
Press FORMAT repeatedly to display 1080 59i GBR.
Press ENTER.

U o

Press Multiburst repeatedly to display Multiburst 1-10 MHz.

NOTE. Press and hold the FRONT PANEL ENABLE button to unlock the front
panel.

6. Start the VMS5000 Option HD application (File > Applications >
VMS5000HD).

7. Select File > Recall Default.

8. Select Configuration > Format.

9. Select RGB Color Space.

10. Select Configuration > Measurements.

11. Select the Multiburst check box and deselect the Color Bars check box.
12. Select Configuration > Operation, and select Channel 4 as the trigger.

13. Select Results > Multiburst.
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14.

15.
16.

17.
18.

19.
20.

21.
22,

23.
24.

25.

Select the VMS000HD Run button. The Multiburst measurement results
table should display with continuously updated measurements.

Change the Averages setting to 64.
Check the following:

a. The six Multiburst packet Amp(dB) readings (1, 2, 4, 6, 8, and 10 MHz)
should be less than +£0.5 dB, for each of the three channels (G, B, R).

b. The flag amplitude for each channel should be 420.0 mV £8.3 mV.
Select the VMS000HD Stop button to halt measurement.

Press the TG700 Multiburst button repeatedly to display Multi-
burst 10-20 MHz.

Select the VM5000HD Run button.
Check the following:

a. The six Multiburst packet Amp(dB) readings (10, 12, 14, 16, 18, and 20
MHZz) should be less than £0.75 dB, for each of the three channels
(G, B, R).

b. The flag amplitude for each channel should be 420.0 mV £8.3 mV.
Select the VMS000HD Stop button to halt measurement.

Press the TG700 Multiburst button repeatedly to display Multiburst
20-30 MHz.

Select the VM5000HD Run button.
Check the following:

a. The six Multiburst (20, 22, 24, 26, 28, and 30 MHz) packet Amp(dB)
readings are less than +0.75 dB, for each of the three channels (G, B, R).

b. The flag amplitude for each channel should be 420.0 mV £8.3 mV.

Exit before the check that follows.

Check Noise Floor  This test verifies the noise floor of the three VM5000 Option HD video input
Measurement Accuracy  channels (CH 1, CH 2, CH 3) and digitizers. Noise floor affects the linearity of
the noise measurement between -60 and -70 dB. The -76 dB Noise Floor
specification ensures a noise floor error contribution of less than 1 dB for a -70
dB noise measurement. Together with the Amplitude Accuracy (Check A) and
Frequency Response (Check B) checks, this indirectly checks the Noise
measurement accuracy.
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Equipment HD CAV Television Test Signal generator (Tektronix TG700 with
required AWVG7 module)
75 Q BNC cable (1)

75 Q precision BNC terminations (4)
Connector, BNC ‘T’ (1)

Prerequisites The test signal generator must warm up for at least 20 minutes prior to
doing this test.

1. Connect the instrument to the test signal source. Refer to Figure B-4 while
doing the following steps:

a. Connect a 75 € BNC cable to the CH1 AWVG7 outputs.

b. Connect the other end of the cable to the VM5000 Option HD CH 4
input and a 75 €2 termination using a BNC “T” connector.

c. Place 75 Q terminations on the VM5000 Option HD CH 1, CH 2, and

CH 3 inputs.
VM5000 Option HD
TG700 with —— 75 Q Termination
AWVG7 module N
{ @ ! l«—— BNC “T” connector

on e o B

Figure B-4: Noise floor accuracy test hookup

Start the VM5000HD application (File > Applications > VMS000HD).
Select File > Recall Default.
Select Configuration > Format and select RGB Color Space.

Select Configuration > Measurements.

CANE U S o

Select the Noise check box and deselect the Color Bars check box.
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7. Select Configuration > Operation, and select Channel 4 as the trigger.
8. Select Results > Noise.

9. Select Unweighted BW in the Filter area.

10. Adjust the Bandwidth Hz setting to 30.0 MHz.

11. Change the Averages setting to 64.

12. Select the VM5000HD Run button. The Noise measurement results table
should appear with continuously updating measurements.

13. Check that the noise measurement dB values are greater than 76 dB for all
three channels.

For example, a 78 dB reading passes. A 74 dB reading fails.

Check Channel Delay  This check verifies the delay match between the VM5000 Option HD CH 1, CH
Match 2, and CH 3 measurement channels. Delay match error affects Channel Delay
measurement accuracy. The specification for delay match error between any two
channels is less than 1 ns.

Equipment HD CAV Television Test Signal generator (Tektronix TG700 with
required AWVG7 module)
75 Q BNC cables (2)

75 Q precision BNC terminations (2)
Connector, BNC ‘T’ (2)
Coupler, Dual-Input BNC ‘T’ cable assembly (1)

Prerequisites The test signal generator must warm up for at least 20 minutes prior to
doing this test.

1. Connect the instrument to the test signal source. Refer to Figure B-5 while
doing the following steps:

a. Connect a 75 Q BNC cable to the upper CH1 AWVG7 output.

b. Connect the other end of the cable to a BNC ‘T’ connector, BNC ‘T’
Cable Assembly, and 75 €2 termination.

c. Connect the BNC ‘“T” Cable Assembly to the VM5000 Option HD CH 1
and CH 2 inputs.

d. Connect a second 75 € BNC cable to the lower CH1 AWVG7 output.
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CH3

TG700 with
AWVG7 module

CH2

CH1

e. Connect the other end of the cable to the VM5000 Option HD CH 4
input and a 75 €2 termination using a BNC “T” connector.

VMS5000 Option HD

—— 75 Q Termination

@;@ @ © @T BNC “T” connector

CH1 | CH2 CH3 CH4 J

BNC “T” cable assembly

BNC “T” connector

75 Q Termination

Figure B-5: Channel delay match test hookup

On the TG700, press the Module button repeatedly to display AWVGT.
Press FORMAT repeatedly to display 1080 59i GBR.
Press ENTER.

U o

Press Multiburst repeatedly to display Multiburst 10-20 MHz.

NOTE. Press and hold the FRONT PANEL ENABLE button to unlock the front
panel.

6. Start the VMS5000 Option HD application (File > Applications >
VMS5000HD).

7. Select File > Recall Default.
8. Select Configuration > Format and select RGB Color Space.

9. While still in Configuration > Measurements, select the Channel Delay
check box and deselect the Color Bars check box.
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10.

11.
12.
13.

14.
15.
16.
17.

Select Configuration > Operation:

a. Deselect all the Warning Reporting boxes.
b. Select Channel 4 as the trigger.

Select Results > Channel Delay.

Change the Averages setting to 64.

Select the VM5000HD Run button. The Channel Delay measurement results
table should appear with continuously updating measurements.

Note the G-B measurement results (including sign) in row 1 of Table B-5.
Reverse the BNC “T” Cable connections on CH 1 and CH 2.
Note the G-B measurement results (including sign) in row 2 of Table B-5.

Subtract line 2 from line 1 in Table B-5. Divide this result by 2 and enter it
in row 3 of Table B-5.

Table B-5: Delay error measurements

G-B (ns) G-R (ns) B-R (ns)

Connection 1

Connection 2

Net delay error (equation 3)

Equation 3: [(Connection 1) - (Connection 2)] + 2

18.

19.

20.

Connect the BNC ‘T’ Cable to the VM5000 Option HD CH 1 and CH 3
inputs. Repeat the procedure in steps 14 through 17 for the G-R measure-
ment.

Connect the BNC “T” Cable to the VM5000 Option HD CH 2 and CH 3
inputs. Repeat the procedure in steps 14 through 17 for the B-R measure-
ment.

Check that the net delay error (row 3) is less than £1 ns for G-B, G-R,
and B-R.

This completes the VM5000 Option HD performance verification.
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Appendix C: Remote Commands

You can control the VM5000 Option HD through the GPIB interface using
commands and queries. The remote commands have the same functionalities as
the menus and buttons in the user interface. You can see the effect of the
commands on the interface as they are received.

NOTE. All oscilloscope platform GPIB commands are supported on the VM5000
Option HD instrument. For documentation on these commands, please refer to
the TDS5000B GPIB Online Programmer Guide provided on the TDS5000B
product software CD (Tektronix part number 063-3692-XX); see the installation
instructions in the CD booklet.

This section covers the following information:

®  Syntax, page C-1

B Remote Startup and Exit of the Instrument, page C-3
®  Command Groups, page C-4

®  Commands, on page C-8

B Warning and Error Messages, on page C-70

Syntax

Commands consist of set commands and query commands (usually simply called
commands and queries). Commands modify the VM5000HD settings or tell the
instrument to perform a specific action. Queries cause the VM5000 Option HD
to return data and information about its status.

Most commands have both a set and a query form, although some commands
only have a query form.

Command Structure ~ VMS5000 Option HD instrument commands have the structure:
:VARIable:VALue "<Command>", "<Argument>"

B You can abbreviate VARIable:VALue to VARI : VAL if desired, and it is case
insensitive.

®m  There are no abbreviated versions of the "<Command>", "<Argument>" part
of the VM5000 Option HD commands; you must enter the full name of this
part of a command.
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The <Command> field is case sensitive, and use of incorrect command case
spelling can result in unexpected results.

All commands have a single <Argument>, which is case insensitive and

cannot be the empty string “”.

Arguments are limited to a maximum of 60 characters. Arguments longer
than 60 characters can cause unexpected behavior of the instrument and may
require the application to be restarted, so this should be avoided.

The comma character (,) and the double quote character (") are special
characters and should not be used in the argument, otherwise unexpected
behavior can result. All other printable characters are permitted in the
argument.

Commands that accept numeric arguments accept either integer or floating
point values, with or without an exponent. This is equivalent to GPIB
standard numeric formats <NR1>, <NR2>, and <NR3>.

The VMS5000 Option HD instrument does not support using a semicolon (;)
to concatenate commands.

Query Structure  VM5000 Option HD instrument queries have the structure:

:VARIable:VALue? "<Command>"

You can abbreviate VARIable:VALue? to VARI :VAL? if desired, and it is case
insensitive.

There are no abbreviated versions of the "<Command>" part of the VM5000
Option HD queries; you must enter the full name of a query.

The <Command> field is case sensitive, and use of incorrect command case
spelling can result in unexpected results.

The VMS5000 Option HD does not support using a semicolon () to
concatenate queries.

Query responses are always in upper case.

The units and precision of result queries are identical to those in the user
interface and those produced by generating a report.
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Remote Startup and Exit of the Instrument
To start the application using remote commands, use the following command:
application:activate "VM5000HD"
To exit the application using remote commands, use the following command:
VARIable:VALue "application", "exit"

You can check whether or not the VMS5000 Option HD application is running
using the following query:

VARIable:VALue? "application"

If the application is running, this query will return “VMS000HD”. However, if
the application is not currently running, it will return the empty string “”.
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Command Groups

Tables C-1 through C-7 list the commands organized by functional group.
(Refer to the Table of Contents for a list of all the commands in alphabetical
order.)

Table C-1: Configuration commands

Header Description

:VARIable:VALue
AutoScale Set or query whether to use auto scale during measurement
ChannelDelaySet Set or query whether to measure channel delay upon Execute
ColorBarsSet Set or query whether to measure Color Bars upon Execute
ColorSpace Set or query the video color space to use for measurement
Format Set or query the video format to use for measurement
MultiBurstSet Set or query whether Multiburst is to be measured upon Execute
NoiseSet Set or query whether Noise is to be measured upon Execute
NonLinearitySet Set or query whether Non-Linearity is to be measured upon Execute
RunMode Set or query run mode to use for measurement
SetupAndOrRun Set or query setup mode to use for measurement
SyncSet Set or query whether Sync is to be measured upon Execute
Trigger Set or query the video trigger to use for measurement
WarningReportingMeasure Set or query whether measurement warnings create a warning message
WarningReportingResults Set or query whether results warnings are to create a warning message
WarningReportingSignal Set or query whether signal warnings create a warning message

Table C-2: Miscellaneous commands

Header Description
:VARIable:VALue
Error Reset error to 0 or query error value.
ID? Query the ID/Version of the application
OPComplete Controls VM5000 Option HD GPIB scripts by ensuring that the previous
command is ready before either querying its value or calling the next
command.
Warning Reset warning to 0 or query warning value.
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Table C-3: Reports commands

Header Description
:VARIable:VALue
ReportGenerate Generates a measurement report of the specified type (if a measure has been
run and results are available), and saves it in the specified file
ReportMeasurements Set or query the measurements to write to the report when ReportGenerate is
called
ReportString Set or query any additional information to write to the report when

ReportGenerate is called

Table C-4: Results commands

Header Description

:VARIlable:VALue:
ChannelDelayAll? Query all three delay measurements performed by Channel Delay
ChannelDelayCh1Ch2? Query the Ch1Ch2 delay measurement performed by Channel Delay
ChannelDelayCh1Ch3? Query the Ch1Ch3 delay measurement performed by Channel Delay
ChannelDelayCh2Ch3? Query the Ch2Ch3 delay measurement performed by Channel Delay

ColorBarsmVCh[1..3]?

Query all eight level values resulting from Color Bars measurement for the
specified channel

ColorBarsmVCh[1..3]Val[1..8]?

Query the value resulting from the specified Color Bars channel and value
measurement

MultiburstAmpdBCh[1..3]?

Query all six amplitude values resulting from the specified Multiburst channel
measurement

MultiburstAmpdBCh[1..3]Val[1..6]?

Query the amplitude value resulting from the specified Multiburst channel and
value measurement

MultiburstFlagmVCh[1..3]?

Query the Flag value resulting from Multiburst measurement for the specified
channel

MultiburstFreqCh[1..3]?

Query all six frequency values resulting from the specified Multiburst channel
measurement

MultiburstFreqCh[1..3]Val[1..6]?

Query the frequency value resulting from the specified Multiburst channel and
value measurement

NoiseAmpdBCh[1..3]?

Query amplitude value (in dB) resulting from Noise measurement for the
specified channel

NoiseAmpmVCh[1..3]?

Query amplitude value (in mV) resulting from Noise measurement for the
specified channel

NonLinearityPctCh[1..3]?

Query all six non-linearity values resulting from the Non-Linearity measurement
for the specified channel
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Table C- 4: Results commands (Cont.)

Header

Description

NonLinearityPctCh[1..3]Max?

Query the maximum non-linearity value for the specified channel

NonLinearityPctCh[1..3]Val[1..5]?

Query the maximum non-linearity value for the specified channel and value

SyncLevelsmV? Query all synchronization levels resulting from the Sync measurement
SyncLevelsmVVal[1..3]? Query the specified synchronization level resulting from the Sync measurement
SyncTimes? Query all synchronization times resulting from the Sync measurement

SyncTimesVal[1..7]?

Query the specified synchronization time resulting from the Sync measurement

Table C-5: Run commands

Header Description
:VARIable:VALue
Execute Execute or stop the current set measurement(s), or query whether any

measurement is currently being executed

Table C-6: Settings commands

Header Description
:VARIable:VALue
DefaultSettings Restore default (factory) settings

RecallSettings

Recall settings stored in the specified path/filename

SaveSettings

Save current settings in the specified path/filename

Table C-7: Setup commands

Header Description
:VARIable:VALue
ChannelDelayAverage Set or query the number of samples over which to average the Channel Delay
measurement
ChannelDelayLine Set or query line number that is to be used for the Channel Delay measure-
ment
ColorBarsAverage Set or query the number of samples over which to average the Color Bars
measurement
ColorBarsLine Set or query line number that is to be used for the Color Bars measurement
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Table C-7: Setup commands (Cont.)

Header Description

MultiburstAverage Set or query the number of samples over which to average the Multiburst
measurement

MultiburstLine Set or query line number that is to be used for the Multiburst measurement

NoiseAverage Set or query the number of samples over which to average the Noise
measurement

NoiseBW Set or query bandwidth of noise filter that is to be used for Noise measure-
ment, if the unweighted noise filter is selected

NoiseFilter Set or query type of noise filter that is to be used for Noise measurement

NoiseLine Set or query line number that is to be used for the Noise measurement

NonLinearityAverage Set or query the number of samples over which to average the Non-Linearity
measurement

NonLinearityLine Set or query line number that is to be used for the Non-Linearity measurement

SyncAverage Set or query the number of samples over which to average the Sync
measurement

SyncLine Set or query line number that is to be used for the Sync measurement
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Commands

The following remote commands are listed in alphabetical order.

AutoScale < setting >

Set or query whether auto scale is to be used during measurement.

Syntax  VARIable:VALue "AutoScale", "< setting >"
VARIabTe:VALue? "AutoScale"

Group  Configuration

Arguments < setting > specifies auto scale setting that is to be used.
Valid settings are: OFF, ON, 0, 1.

Returns  Query returns the current specified setting.

Examples  VARIable:VALue "AutoScale", "ON"
VARIable:VALue? "AutoScale"

Query may return: "AutoScale 0"
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ChannelDelayAll?

Syntax
Group
Arguments

Related Commands

Returns

Examples

Query all 3 delay measurements performed by Channel Delay.

VARIable:VALue? "ChannelDelayAll"

Results

None

ChannelDelayCh1Ch2
ChannelDelayCh1Ch3
ChannelDelayCh2Ch3

Returns all three delay measurements (in nanoseconds) performed by Channel
Delay, in this order: Ch1Ch2 Ch1Ch3 Ch2Ch3.

Returns "---" if no valid measurement currently available.

VARIable:VALue? "ChannelDelayAll"

Query may return: "ChannelDelayAll 1.84 0.04 -1.54"
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ChannelDelayAverage < samples >

Set or query the number of samples over which to average the Channel Delay
measurement.

Syntax VARIable:VALue "ChannelDelayAverage", "< samples >"
VARIable:VALue? "ChannelDelayAverage"

Group  Setup

Arguments < samples > can be integer or floating point, but will be rounded to the next
lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Returns  Query returns the current number of samples for Channel Delay measurement.

Examples  VARIable:VALue "ChannelDelayAverage", "1"
VARIable:VALue? "ChannelDelayAverage"

Query may return: "ChannelDelayAverage 8"
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ChannelDelayCh1Ch2?

Syntax
Group
Arguments

Related Commands

Returns

Examples

Query the Ch1Ch2 delay measurement performed by Channel Delay.

VARIable:VALue? "ChannelDelayChlCh2"

Results

None

ChannelDelayAll
ChannelDelayCh1Ch3
ChannelDelayCh2Ch3

Returns the Ch1Ch2 delay measurement (in nanoseconds) performed by Channel
Delay.

Returns "---" if no valid measurement is currently available.

VARIable:VALue? "ChannelDelayChlCh2

Query may return: "ChannelDelayCh1Ch2 1.84"
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ChannelDelayCh1Ch3?

Syntax
Group
Arguments

Related Commands

Returns

Examples

C-12

Query the Ch1Ch3 delay measurement performed by Channel Delay.

VARIable:VALue? "ChannelDelayCh1Ch3"

Results

None

ChannelDelayAll
ChannelDelayCh1Ch2
ChannelDelayCh2Ch3

Returns the Ch1Ch3 delay measurement (in nanoseconds) performed by Channel
Delay.

Returns "---" if no valid measurement currently available.

VARIable:VALue? "ChannelDelayCh1Ch3"

Query may return: "ChannelDelayCh1Ch3 0.04"
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ChannelDelayCh2Ch3?

Syntax
Group
Arguments

Related Commands

Returns

Examples

Query the Ch2Ch3 delay measurement performed by Channel Delay.

VARIable:VALue? "ChannelDelayCh2Ch3"

Results

None

ChannelDelayAll
ChannelDelayCh1Ch2
ChannelDelayCh1Ch3

Returns the Ch2Ch3 delay measurement (in nanoseconds) performed by Channel
Delay.

Returns "---" if no valid measurement is currently available.

VARIable:VALue? "ChannelDelayCh2Ch3"

Query may return: "ChannelDelayCh2Ch3 -1.54"
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ChannelDelayLine < linenumber >

Syntax

Group

Arguments

Returns

Examples

Set or query line number that is to be used for Channel Delay measurement.

VARIable:VALue "ChannelDelayLine", "< Tinenumber >"
VARIable:VALue? "ChannelDelayLine"

Setup

< linenumber > can be integer or floating point, but will be rounded to the next
lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Query returns the current line number for Channel Delay measurement.

VARIable:VALue "ChannelDelayLine", "200"
VARIable:VALue? "ChannelDelayLine"

Query may return: "ChannelDelayLine 325"
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ChannelDelaySet < setting >

Syntax

Group

Arguments

Related Commands

Returns

Examples

Set or query whether Channel Delay is to be measured upon Execute.

VARIable:VALue “ChannelDelaySet”, “< setting >”
VARIable:VALue? “ChannelDelaySet”

Configuration

< setting > specifies whether to perform Channel Delay measurement upon
Execute.
Valid values are: OFF, ON, 0, 1.

Execute
ReportMeasurements

Query returns 0 or 1 depending on whether ChannelDelaySet measurement is
selected.

VARIable:VALue “ChannelDelaySet”, “ON”
VARIable:VALue? “ChannelDelaySet”
Query may return: “ChannelDelaySet 1”
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ColorBarsAverage < samples >

Set or query the number of samples over which to average the Color Bars
measurement.

Syntax  VARIable:VALue "ColorBarsAverage", "< samples >"
VARIable:VALue? "ColorBarsAverage"

Group  Setup

Arguments < samples > can be integer or floating point, but will be rounded to the next
lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Returns  Query returns the current number of samples for Color Bars measurement.

Examples  VARIable:VALue "ColorBarsAverage", "1"
VARIable:VALue? "ColorBarsAverage"

Query may return: "ColorBarsAverage 8"
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ColorBarsLine < linenumber >

Syntax

Group

Arguments

Returns

Examples

Set or query line number that is to be used for Color Bars measurement.

VARIable:VALue "ColorBarsLine", "< 1linenumber >"
VARIable:VALue? "ColorBarsLine"

Setup

< linenumber > can be integer or floating point, but will be rounded to the next
lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Query returns the current line number for Color Bars measurement.

VARIable:VALue "ColorBarsLine", "200"
VARIable:VALue? "ColorBarsLine"

Query may return: "ColorBarsLine 325"

VMS5000 Option HD Automatic Video Measurement Set User Manual C-17



Appendix C: Remote Commands

ColorBarsmVCh[1..3]?

Query all eight level values (in mV) resulting from the Color Bars measurement
for the specified channel.

Syntax  VARIable:VALue? "ColorBarsmVCh[1..3]"
Group  Results
Arguments  None
Related Commands  ColorBarsmVCh|[1..3]Val[1..8]

Returns  Returns all eight delay measurements (in mV) performed by Color Bars, in this
order: White Yellow Cyan Green Magenta Red Blue Black.

Returns "---" if no valid measurement is currently available.

Examples  VARIable:VALue? "ColorBarsmVChl"

Query may return:
"ColorBarsmVChl 699.76 650.52 552.75 501.98 201.89 150.74 52.11
0.49"
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ColorBarsmVCh[1..3]Val[1..8]?

Syntax

Group

Arguments

Related Commands

Returns

Examples

VMS5000 Option HD Automatic Video Measurement Set User Manual

Query the value (in mV) resulting from Color Bars measurement for the
specified channel and value.

VARIable:VALue? "ColorBarsmVCh[1..3]Val[l..8]"

Results

None

ColorBarsmVCh[1..3]

Returns the specified Color Bars value (in mV).
Values must be in the range: 1..8
Values must designate the following colors:

1-White 2-Yellow 3-Cyan 4-Green 5-Magenta 6-Red 7-Blue 8-Black.

Returns "---" if no valid measurement is currently available

VARIable:VALue? "ColorBarsmVCh2Val6"

Query may return: "ColorBarsmVCh2Val6 -78.89"
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ColorBarsSet < setting >

Set or query whether Color Bars is to be measured upon Execute.

Syntax  VARIable:VALue "ColorBarsSet", "< setting >"
VARIabTe:VALue? "ColorBarsSet"

Group  Configuration

Arguments < setting > specifies whether to perform Color Bars measurement upon
Execute. Valid values are: OFF, ON, 0, 1

Related Commands  Execute
ReportMeasurements

Returns  Query returns 0 or 1 depending on whether ColorBarsSet measurement is
selected.

Examples  VARIable:VALue "ColorBarsSet", "ON"
VARIable:VALue? "ColorBarsSet"

Query may return: "ColorBarsSet 1"
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ColorSpace < colorspace >

Syntax

Group

Arguments

Returns

Examples

Set or query video color space to use for measurement.

VARIable:VALue "ColorSpace", "< colorspace >"
VARIable:VALue? "ColorSpace"

Configuration

< colorspace > specifies color space that is to be set.
Valid color spaces are: YPbPr, RGB

Query returns the current specitied color space

VARIable:VALue "ColorSpace", "YPbPr"
VARIable:VALue? "ColorSpace"

Query may return: "ColorSpace YPbPr"
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DefaultSettings

Command restores default (factory) settings.
Query returns “OK” unless the command is still being processed, in which case
it returns “1”.

Restores default (factory) settings.

Syntax  VARIable:VALue "DefaultSettings", "1"
VARIable:VALue? "DefaultSettings"

Group  Settings
Arguments  Valid value is 1.

Returns  Query returns "0K” unless the command is still being processed, in which case it
returns "1".

Examples  VARIable:VALue "DefaultSettings", "1"
VARIable:VALue? "DefaultSettings"

Query may return: "DefaultSettings OK"
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Error < setting >

Command can be used to reset Error to “0”.
Query returns the most recent error reported by the application, or “0” if no
errors have occurred since Error was last reset.

Initialized to “0” on startup.

Syntax  VARIable:VALue "Error" < setting >
VARIabTe:VALue? "Error"

Group  Miscellaneous

Arguments < setting > resets Error to “0”.
Valid values are: OFF, 0.

Returns  Returns the most recent error reported by the application. Returns “0” if no error
has occurred since the Error command was last reset. For a listing of all possible
errors, refer to Table C-9 on page C-71.

Examples  VARIable:VALue "Error", "OFF"
VARIable:VALue? "Error"

Query may return: "Error No Measurement Selected"
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Execute < setting >

C-24

Syntax

Group

Arguments

Related Commands

Returns

Examples

Execute/stop the current set measurement(s), or query whether any measurement
is currently being executed. If the measurement is already in the mode specified
by the setting, the command has no effect. For example, if a measurement is
already running and “VARIable:VALue “Execute”, “1” is received, the measure-
ment will continue to run.

VARIable:VALue "Execute", "< setting >"
VARIable:VALue? "Execute"

Run

< setting > Valid settings are: OFF, 0, ON, 1.
OFF is the same as 0, and ON is the same as 1.

ChannelDelaySet
ColorBarSet
MultiburstSet
NoiseSet
NonLinearitySet
SyncSet

Query returns 1 if any measurement is currently being executed, otherwise it
returns 0.

VARIable:VALue "Execute", "1"
VARIable:VALue? "Execute"

Query may return: "Execute 1"
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Format < format >

Set or query video format to use for measurement. No defaults.

If you get the error message, “Invalid Argument”, make sure that you specified a
valid format.

Syntax  VARIable:VALue "Format", "< format >"
VARIable:VALue? "Format"

Group  Configuration

Arguments < format > specifies format that is to be set.
Valid formats are: HD480P60, HD576P50, HD720P60, HD1080150,
HD1080160, SXGAP60

Returns  Query returns the current specified format.

Examples  VARIable:VALue "Format", "HD480P60"
VARIable:VALue? "Format"

Query may return: "Format HD1080160"
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ID?
Syntax
Group
Arguments
Returns
Examples
C-26

Query the ID/Version of the application.

VARIable:VALue? "ID"

Miscellaneous

None

Returns the application’s ID

VARIable:VALue? "ID"

Query may return: "ID Tek/VM5000HD FV:1.0"
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MultiburstAmpdBCh[1..3]?

Syntax

Group

Arguments

Related Commands

Returns

Examples

Query all six amplitude values (in dB) resulting from Multiburst measurement
for the specified channel.

VARIable:VALue? "MultiburstAmpdBCh[1..3]"

Results

None

MultiburstAmpdBCh[1..3]Val[1..6]

Returns all six amplitude values (in dB) in burst order.

Returns "---" if no valid measurement currently available.

VARIable:VALue? "MultiburstAmpdBCh2"

Query may return:
"MultiburstAmpdBCh2 -0.09 -0.18 -0.14 -0.13 -0.08 —0.02"
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MultiburstAmpdBCh[1..3]Val[1..6]?

Syntax

Group

Arguments

Related Commands

Returns

Examples

C-28

Query the amplitude (in dB) resulting from Multiburst measurement for the
specified channel and value.

VARIable:VALue? "MultiburstAmpdBCh[1..3]Val[l..6]"

Results

None

MultiburstAmpdBCh[1..3]

Returns the specified Multiburst value (in dB).

Returns "---" if no valid measurement is currently available.

VARIable:VALue? "MultiburstAmpdBChlval2"

Query may return: "MultiburstAmpdBChlVal2 -0.26"
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MultiburstAverage < samples >

Syntax

Group

Arguments

Returns

Examples

Set or query the number of samples over which to average the Multiburst
measurement.

VARIable:VALue "MultiburstAverage", "< samples >"
VARIable:VALue? "MultiburstAverage"

Setup

< samples > can be integer or floating point, but will be rounded to the next
lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Query returns the current number of samples for Multiburst measurement.

VARIable:VALue "MultiburstAverage", "1"
VARIable:VALue? "MultiburstAverage"

Query may return: "MultiburstAverage 8"
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MultiburstFlagmVCh[1..3]?

Syntax
Group
Arguments

Returns

Examples

C-30

Query the Flag value (in mV) resulting from Multiburst measurement for the
specified channel.

VARIable:VALue? "MultiburstFlagmVCh[1..3]"

Results

None

Returns the Flag value (in mV).

Returns "---" if no valid measurement currently available.

VARIable:VALue? "MultiburstFlagmVCh3"

Query may return: "MultiburstFlagmVCh3 428.01"
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MultiburstFreqCh[1..3]?

Syntax

Group

Arguments

Related Commands

Returns

Examples

Query all six frequency values (in MHz) resulting from Multiburst measurement
for the specified channel.

VARIable:VALue? "MultiburstFreqCh[1..3]"

Results

None

MultiburstFreqCh[1..3]Val[1..6]

Returns all six frequency values (in MHz) in burst order.

Returns "---" if no valid measurement currently available.

VARIable:VALue? "MultiburstFreqChl"

Query may return:
“MultiburstFreqChl 10.00 12.00 14.00 16.00 18.01 20.00"
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MultiburstFreqCh[1..3]Val[1..6]?

Syntax

Group

Arguments

Related Commands

Returns

Examples

C-32

Query the frequency (in MHz) resulting from Multiburst measurement for the
specified channel and value.

VARIable:VALue? "MultiburstFreqCh[1..3]Val[l..6]"

Results

None

MultiburstFreqCh[1..3]

Returns the specified Multiburst frequency (in MHz).

Returns "---" if no valid measurement currently available.

VARIable:VALue? "MultiburstFreqChlVal2"

Query may return: "MultiburstFreqChlvVal2 12.00"
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MultiburstLine < linenumber >

Syntax

Group

Arguments

Returns

Examples

Set or query line number that is to be used for Multiburst measurement.

VARIable:VALue "MultiburstLine", "< Tinenumber >"
VARIable:VALue? "MultiburstLine"

Setup

< linenumber > can be an integer or floating point, but will be rounded to the
next lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Query returns the current line number for Multiburst measurement.

VARIable:VALue "MultiburstLine", "200"
VARIable:VALue? "MultiburstLine"

Query may return: "MultiburstLine 325"

VMS5000 Option HD Automatic Video Measurement Set User Manual C-33



Appendix C: Remote Commands

MultiburstSet < setting >

Set or query whether Multiburst is to be measured upon Execute.

Syntax  VARIable:VALue "MultiburstSet", "< setting >"
VARIabTe:VALue? "MultiburstSet"

Group  Configuration

Arguments < setting > specifies whether to perform Multiburst measurement upon
Execute. Valid values are: OFF, ON, 0, 1

Related Commands  Execute
ReportMeasurements

Returns  Query returns 0 or 1 depending on whether MultiburstSet measurement is
selected.

Examples  VARIable:VALue "MultiburstSet", "ON"
VARIabTe:VALue? "MultiburstSet"

Query may return: "MultiburstSet 1"
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NoiseAmpdBCh[1..3]?

Query amplitude value (in dB) resulting from Noise measurement for the
specified channel.

Syntax  VARIable:VALue? "NoiseAmpdBCh[1..3]"
Group  Results
Arguments  None

Returns  Returns amplitude value (in dB).

Returns "---" if no valid measurement currently available.

Examples  VARIable:VALue? "NoiseAmpdBCh2"

Query may return: "NoiseAmpdBCh2 66.43"
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NoiseAmpmVCh[1..3]?

Query amplitude value (in mV) resulting from a Noise measurement for the
specified channel.

Syntax  VARIable:VALue? "NoiseAmpmVCh[1..3]"
Group  Results
Arguments  None

Returns  Returns amplitude value (in mV).

Returns “~--""if no valid measurement is currently available.

Examples  VARIable:VALue? "NoiseAmpmVCh2"

Query may return: "NoiseAmpmVCh2 0.33"
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NoiseAverage < samples >

Syntax

Group

Arguments

Returns

Examples

Set or query the number of samples over which to average the Noise measure-
ment.

VARIable:VALue "NoiseAverage", "< samples >"
VARIable:VALue? "NoiseAverage"

Setup

< samples > Can be integer or floating point, but will be rounded to the next
lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Query returns the current number of samples for Noise measurement.

VARIable:VALue "NoiseAverage", "1"
VARIable:VALue? "NoiseAverage"

Query may return: "NoiseAverage 8"
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NoiseBW < bandwidth >

Set or query bandwidth of noise filter that is to be used for noise measurement, if
the unweighted noise filter is selected.

Syntax  VARIable:VALue "NoiseBW", "< bandwidth >"
VARIabTe:VALue? "NoiseBW"

Group  Setup

Arguments < bandwidth > specifies bandwidth of unweighted noise filter, in Hz. Can be
integer or floating point. Values outside the range will be adjusted to be within
range. Floating point notation is allowed.

Related Commands  NoiscFilter
Returns  Query returns the current unweighted noise filter bandwidth, in Hz.

Examples VARIabTe:VALue "NoiseBW", "30000000"
VARIable:VALue "NoiseBW", "3.2E7"
VARIable:VALue? "NoiseBW"

Query may return: "NoiseBW 50000000"
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NoiseFilter < noisefilter >

Syntax

Group

Arguments

Related Commands
Returns

Examples

Set or query type of noise filter that is to be used for noise measurement.

VARIable:VALue "NoiseFilter", "< noisefilter >"
VARIabTe:VALue? "NoiseFilter"

Setup

< noisefilter > specifies type of noise filter that is to be used for noise
measurement. Valid noise filters are: Off, Unified, Unweighted.

NoiseBW

Query returns the current specified noise filter.

VARIable:VALue "NoiseFilter", "Unified"
VARIabTe:VALue? "NoiseFilter"

Query may return: "NoiseFilter Off"
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NoiseLine < linenumber >

Syntax

Group

Arguments

Returns

Examples

C-40

Set or query line number that is to be used for Noise measurement.

VARIabTe:VALue "NoiseLine", "< linenumber >"
VARIabTe:VALue? "NoiseLine"

Setup

< linenumber > Can be integer or floating point, but will be rounded to the
next lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Query returns the current line number for Noise measurement.

VARIable:VALue "NoiseLine", "200"
VARIable:VALue? "NoiselLine"

Query may return: "NoiseLine 325"
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NoiseSet < setting >

Syntax

Group

Arguments

Related Commands

Returns

Examples

Set or query whether Noise is to be measured upon Execute.

VARIable:VALue "NoiseSet", "< setting >"
VARIable:VALue? "NoiseSet"

Configuration

< setting > specifies whether to perform Noise measurement upon Execute.
Valid values are: OFF, ON, 0, 1.

Execute
NoiseMeasurements

Query returns 0 or 1 depending on whether NoiseSet measurement is selected

VARIabTe:VALue "NoiseSet", "ON"
VARIable:VALue? "NoiseSet"

Query may return: "NoiseSet 1"
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NonLinearityAverage < samples >

Set or query the number of samples over which to average the Non-Linearity
measurement.

Syntax VARIable:VALue "NonLinearityAverage", "< samples >"
VARIable:VALue? "NonLinearityAverage"

Group  Setup

Arguments < samples > Can be integer or floating point, but will be rounded to the next
lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Returns  Query returns the current number of samples for Non-Linearity measurement.

Examples  VARIable:VALue "NonLinearityAverage", "1"
VARIable:VALue? "NonLinearityAverage"

Query may return: "NonLinearityAverage 8"
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NonLinearityLine < linenumber >

Syntax

Group

Arguments

Returns

Examples

Set or query line number that is to be used for Non-Linearity measurement.

VARIable:VALue "NonLinearityLine", "< Tinenumber >"
VARIable:VALue? "NonLinearityLine"

Setup

< linenumber > Can be integer or floating point, but will be rounded to the
next lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Query returns the current line number for Non-Linearity measurement.

VARIable:VALue "NonLinearityLine", "200"
VARIable:VALue? "NonLinearityLine"

Query may return: "NonLinearityLine 325"
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NonLinearityPctCh[1..3]?

Query all six non-linearity values (as a percentage) resulting from Non-Linearity
measurement for the specified channel.

Syntax  VARIable:VALue? "NonLinearityPctCh[1..3]"
Group  Results
Arguments  None

Related Commands  NonLinearityPctCh[1..3]Max
NonLinearityPctCh[1..3]Val[1..5]

Returns  Returns all six non-linearity values (as a percentage) in this order: Maximum
Stepl Step2 Step3 Step4 StepS5.

Returns "---" if no valid measurement is currently available

Examples  VARIable:VALue? "NonLinearityPctCh3"

Query may return:
"NonLinearityPctCh3 0.82 0.00 0.82 0.69 0.21 0.28"
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NonLinearityPctCh[1..3]Max?

Syntax
Group
Arguments

Related Commands

Returns

Examples

Query the maximum non-linearity value (as a percentage) resulting from a
Non-Linearity measurement for the specified channel.

VARIable:VALue? "NonLinearityPctCh[1l..3]Max"

Results

None

NonLinearityPctCh[1..3]
NonLinearityPctCh[1..3]Val[1..5]

Returns maximum non-linearity value (as a percentage) for specified channel.

Returns "---" if no valid measurement currently available.
y

VARIable:VALue? "NonLinearityPctCh3Max"

Query may return: "NonLinearityPctCh3Max 0.82"
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NonLinearityPctCh[1..3]Val[1..5]?

Query the non-linearity value (as a percentage) resulting from a Non-Linearity
measurement for the specified channel and step.

Syntax  VARIable:VALue? "NonLinearityPctCh[1..3]Val[l..5]"
Group  Results
Arguments  None

Related Commands  NonLinearityPctCh[1..3]
NonLinearityPctCh[1..3]Max

Returns  Returns non-linearity value (as a percentage) for specified channel and step.

Returns "---" if no valid measurement is currently available.

Examples  VARIable:VALue? "NonLinearityPctCh3Val4"

Query may return: "NonLinearityPctCh3Val4 0.21"
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NonLinearitySet < setting >

Syntax

Group

Arguments

Returns

Examples

Set or query whether Non-Linearity is to be measured upon Execute.

VARIable:VALue "NonLinearitySet", "< setting >"
VARIable:VALue? "NonLinearitySet"

Configuration

< setting > specifies whether to perform Non-Linearity measurement upon
Execute.

Valid values are: OFF, ON, 0, 1.

Query returns 0 or 1 depending on whether NonLinearitySet measurement is
selected.

VARIable:VALue "NonLinearitySet", "ON"
VARIable:VALue? "NonLinearitySet"

Query may return: "NonLinearitySet 1"
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OPComplete < setting >

C-48

Syntax

Group

Arguments

Returns

OPComplete is set to “1” whenever a VM5000 Option HD GPIB command has
been received and processed and a new command is ready to be processed
(except for the resetting of OPComplete itself, which sets OPComplete to “07).

OPComplete can only be reset to “0” by the user, and it can only be set to “1”
when a command has been sent and the next command is ready to be input.

OPComplete is designed to control VM5000 Option HD GPIB scripts by
ensuring that the previous command is ready before either (1) querying it’s value
or (2) calling the next command. It should therefore be checked and reset in
between each command, and before querying the new setting.

If a command sets its value to the same value that it is currently set to, OPCom-
plete will not be set to “1”. To avoid this, either set Header to “ON”, or use all
lowercase arguments for text (such as “hd480p60”and “on”), and floating-point
input for numeric values (such as 21.0 instead of 21). This will always cause
OPComplete to be set.

Initialized to “0” on startup.

VARIable:VALue "OPComplete", "< setting >"
VARIable:VALue? "OPComplete"

Miscellaneous

< setting > - resets OPComplete so it is ready for the next command.
Valid values are: OFF, 0.

Query returns “1” if a command has been completed since OPComplete was last
reset, otherwise it returns “0”
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Examples  VARIable:VALue "OPComplete", "OFF"
VARIable:VALue? "OPComplete"

Query may return: "OPComplete 1"
A typical general-case usage of OPComplete might be:

VARIable:VALue "OPComplete", "OFF"
// reset first so we know it is set to "0"

VARIable:VALue "Commandl", "Argumentl"
// call first command

While ((VARIable:VALue? "OPComplete") == "0") (
Wait;
)

// wait till first command is ready before calling next command

// Now repeat the same process for the next command:
VARIable:VALue "OPComplete", "OFF"

// reset first so we know it is set to "0"
VARIable:VALue "Command2", "Argument2"
// call next command

While ((VARIable:VALue? "OPComplete") == "0") (
Wait;
)

// wait till this command is ready before calling next command
// and so on for subsequent commands
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RecallSettings < pathstring >

C-50

Syntax

Group

Arguments

Related Commands

Returns

Examples

Command recalls settings stored in the specified path/filename.
Query returns “OK” unless the command is still being processed, in which case
it returns the current pathstring argument.

If you only specity the filename, the default path “c:\VM5000HD” is used. The
file specified in pathstring must have the default extension “.vmset”, or else it
will be appended.

If you get the error message, “Invalid Filename”, confirm that you typed the
correct path and that your path is no more than 60 characters.

VARIable:VALue "RecallSettings", "< pathstring >"
VARIable:VALue? "RecallSettings"

Settings

<pathstring> specifies the path/filename where the setup file is stored. Can
either be (1) the full path and filename, or (2) just the filename, and the default
path “c:\VM5000HD” will be used. The default extension “.vmset” will be
appended if it is not specified. The pathstring must be less than 60 characters in
length, otherwise the command may not be completed successtully.

SaveSettings

Query returns “OK” unless the command is still being processed, in which case
it returns the current pathstring argument.

VARIable:VALue "RecallSettings", "c:\VM5000HD\Tekl.vmset"
VARIable:VALue "RecallSettings", "Tek2.vmset"
VARIable:VALue? "RecallSettings"

Query may return: "RecallSettings OK"
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ReportGenerate < pathstring >

Command generates a measurement report of the specified type (if a measure has
been run and results are available), and saves it in the file specified by pathstring.
The type of file (.1tf, .csv or .pdf) is determined by the file extension in the
pathstring. If the extension does not match one of these endings, a .pdf file is
created by default and “.pdf” is appended to the end of the pathstring.

Query returns “OK” unless the command is still being processed, in which case
it returns the current pathstring argument.

If you get the error message “Invalid Filename,” confirm that you typed the
correct path and that your path is no more than 60 characters.

Syntax VARIable:VALue "ReportGenerate", "< pathstring >"
VARIable:VALue? "ReportGenerate"

Group  Reports

Arguments  <pathstring> path/filename where file is to be stored. Can either be (1) the full
path and filename, or (2) just the filename, and the default path “c:\VM5000HD”
will be used. The default extension “.pdf” will be appended if it is not specified.
The specified directory will be created if it doesn’t currently exist. The pathstring
must be less than 60 characters in length, otherwise the command may not be
completed successfully.

Related Commands  ReportString
ReportMeasurements

Returns  Query returns “OK” unless the command is still being processed, in which case
it returns the current pathstring argument.

Examples  VARIable:VALue "ReportGenerate", "J:\netpath\colorbars.csv"
VARIable:VALue "ReportGenerate", "noise02"
VARIable:VALue? "ReportGenerate"

Query may return: "ReportGenerate OK"
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ReportMeasurements < setting >

Syntax

Group

Arguments

Related Commands

Returns

Examples

C-52

Set or query the measurements to write to the report when ReportGenerate is
called.

Set to ”All” when application starts.

VARIable:VALue "ReportMeasurements", "< measuremode>"
VARIable:VALue? "ReportMeasurements"

Reports

< measuremode > specifies the measurements that are to be written to the report
when ReportGenerate is called. Valid measuremode values are All and Selected.
All reports all current valid measurements results, while Selected reports only
those measurements that are currently set.

ChannelDelaySet
ColorBarsSet
MultiburstSet
NoiseSet
NonLinearitySet
ReportGenerate
SyncSet

Query returns the current specified report measurement mode.

VARIable:VALue "ReportMeasurements", "A11"
VARIable:VALue? "ReportMeasurements"

Query may return: "ReportMeasurements Selected"
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ReportString < string >

Syntax

Group

Arguments

Related Commands
Returns

Examples

Set or query user-specified information to write to the report when
ReportGenerate is called.

€

Initialized to empty string “” on startup.

VARIable:VALue "ReportString", "< string >"
VARIable:VALue? "ReportString"

Reports

< string > can be up to 46 characters in length. The comma and double quote
characters are not permitted and their usage may result in unexpected program
behavior. All other printable characters are permitted.

ReportGenerate

Query returns the currently specified report string.

VARIable:VALue "ReportString", "Tested by Joe B - DUT Al"
VARIable:VALue? "ReportString"

Query may return: "ReportString Tested by Joe B - DUT Al"

If assigning consecutive long strings to ReportString, truncation of the second
string may occur if the length of the consecutive strings exceeds a limit (67
characters if Header is ON). For example:

VARiable:VALue "ReportString", "This is a long string which has
45 characters"

VARiable:VALue? "ReportString"
"ReportString This is a long string which has 45 characters"

VARiable:VALue "ReportString", "This string will be truncated, it
is 45 chars"

VARiable:VALue? "ReportString"
"ReportString This string will be tr"
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To avoid this truncation, send a short string to ReportString prior to sending the
second string.

VARiable:VALue "ReportString", "This is a long string which has
45 characters"
VARiable:VALue? "ReportString"

"ReportString This is a long string which has 45 characters"

VARiable:VALue "ReportString", "short"
VARiable:VALue? "ReportString"
"ReportString short"

VARiable:VALue "ReportString", "This string won't be truncated,
it is 46 chars"
VARiable:VALue? "ReportString"

"ReportString This string won't be truncated, it is 46 chars"

C-54 VM5000 Option HD Automatic Video Measurement Set User Manual



Appendix C: Remote Commands

RunMode < runmode >

Set or query the run mode to use for measurement.

Syntax VARIable:VALue "RunMode", "< runmode >"
VARIable:VALue? "RunMode"

Group  Configuration

Arguments < runmode > specifies the run mode that is to be used.
Valid run modes are: Once, Continuously.

Returns Query returns the currently specified run mode.

Examples  VARIable:VALue "RunMode", "Once"
VARIable:VALue? "RunMode"

Query may return: "RunMode Continuously"
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SaveSettings < pathstring >
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Syntax

Group

Arguments

Related Commands

Returns

Examples

Command saves current settings in the specified path/filename.
Query returns “OK” unless the command is still being processed, in which case
it returns the current pathstring argument.

If you only specity the filename, the default path “c:\VM5000HD” is used. The
file will be saved using the default extension “.vmset”.

If you get the error message “Invalid Filename,” confirm that you typed the
correct path and that your path is no more than 60 characters.

VARIable:VALue "SaveSettings", "< pathstring >"
VARIable:VALue? "SaveSettings"

Settings

<pathstring> specifies the path/filename where the file is to be stored. Can
either be (1) the full path and filename, or (2) just the filename, and the default
path “c:\VM5000HD” will be used. The default extension “.vmset” will be
appended if it is not specified. The specified directory will be created if it doesn’t
currently exist. The pathstring must be less than 60 characters in length,
otherwise the command may not be completed successfully.

RecallSettings

Query returns "OK" unless the command is still being processed, in which case it
returns the current pathstring argument.

VARIable:VALue "SaveSettings", "c:\VM5000HD\Tekl.vmset"
VARIable:VALue "SaveSettings", "Tek2.vmset"
VARIable:VALue? "SaveSettings"

Query may return: "SaveSettings OK"
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SetupAndOrRun < setuprunmode >

Syntax

Group

Arguments

Returns

Examples

Set or query the setup run mode to use for measurement.

VARIable:VALue "SetupAndOrRun", "< setuprunmode >"
VARIable:VALue? "SetupAndOrRun"

Configuration

< setuprunmode > specifies how to perform setup when performing a
measurement. Valid modes are: SetupAndRun, SetupOnly, RunOnly.

Query returns the current specified setuprunmode.

VARIable:VALue "SetupAndOrRun", "SetupAndRun"
VARIable:VALue? "SetupAndOrRun"

Query may return: "SetupAndOrRun SetupAndRun"
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SyncAverage < samples >

Set or query the number of samples over which to average the Sync measure-
ment.

Syntax VARIable:VALue "SyncAverage", "< samples >"
VARIable:VALue? "SyncAverage"

Group  Setup

Arguments  <samples > can be integer or floating point, but will be rounded to the next
lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Returns  Query returns the current number of samples for Sync measurement.

Examples  VARIable:VALue "SyncAverage", "1"
VARIable:VALue? "SyncAverage"

Query may return: "SyncAverage 8"
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SyncLevelsmV?

Syntax

Group

Arguments

Related Commands

Returns

Examples

Query all synchronization levels (in mV) resulting from a Sync measurement.
For Tri-Level Sync, this returns three levels.
For Bi-Level Sync, this returns two levels.

VARIable:VALue? "SyncLevelsmV"

Results

None

SyncLevelsmVVal[1..3]

Returns all synchronization levels (in mV) in this order:
For Tri-Level: FrontPorchLevel NegativeSyncLevel PositiveSyncLevel.
For Bi-Level:  FrontPorchLevel SyncLevel.

Returns "---" if no valid measurement currently available.

VARIable:VALue? "SyncLevelsmV"

Query may return: "SyncLevelsmV 0.89 -298.31 299.11"
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SyncLevelsmVVal[1..3]?

Query the specified synchronization level (in mV) resulting from a Sync
measurement.

Syntax  VARIable:VALue? "SyncLevelsmVVal[l..3]"
Group  Results
Arguments  None
Related Commands  SyncLevelsmV

Returns  Returns specified synchronization level (in mV).
Values must be in the following ranges:
For Tri-Level, 1..3
For Bi-Level, 1..2
Values must designate the following levels:
For Tri-Level: 1-FrontPorchLevel, 2-NegativeSyncLevel, 3-PositiveSyncLevel.
For Bi-Level: 1-FrontPorchLevel, 2-SyncLevel.

Returns “~--" if no valid measurement currently available

Examples  VARIable:VALue? "SyncLevelsmVVal3"

Query may return: "SyncLevelsmVVal3 299.11"
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SyncLine < linenumber >

Syntax

Group

Arguments

Returns

Examples

Set or query line number that is to be used for Sync measurement.

VARIable:VALue "SyncLine", "< Tlinenumber >"
VARIable:VALue? "SyncLine"

Setup

< linenumber > can be an integer or floating point, but will be rounded to the
next lowest integer. Values outside the range will be adjusted to be within range.
Floating point notation is allowed.

Query returns the current line number for Sync measurement.

VARIable:VALue "SyncLine", "200"
VARIable:VALue? "SyncLine"

Query may return: "SyncLine 325"
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SyncSet < setting >

Syntax

Group

Arguments

Related Commands

Returns

Examples

C-62

Set or query whether Sync is to be measured upon Execute.

VARIable:VALue "SyncSet", "< setting >"
VARIable:VALue? "SyncSet"

Configuration

< setting > specifies whether to perform Sync measurement upon Execute.
Valid values are: OFF, ON, 0, 1.

Execute
ReportMeasurements

Query returns 0 or 1 depending on whether SyncSet measurement is selected.

VARIable:VALue "SyncSet", "ON"
VARIable:VALue? "SyncSet"

Query may return: "SyncSet 1"
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SyncTimes?

Syntax

Group

Arguments

Related Commands

Returns

Examples

Query all synchronization times (in nanoseconds) resulting from a Sync
measurement.

For Tri-Level Sync, this returns seven times.
For Bi-Level Sync, this returns five times.

VARIable:VALue? "SyncTimes"

Results

None

SyncTimesVal[1..7]

Returns all synchronization times (in nanoseconds) in the order:

For Tri-Level: FrontPorch NegativeSyncFall NegativeSyncWidth SyncRise
PositiveSyncWidth PositiveSyncFall BackPorch.

For Bi-Level: FrontPorch NegativeSyncFall NegativeSyncWidth SyncRise
BackPorch.

Returns "---" if no valid measurement currently available

VARIable:VALue? "SyncTimes"

Query may return:
"SyncTimes 3822.39 59.03 592.01 52.61 590.40 55.24 1995.19"

VMS5000 Option HD Automatic Video Measurement Set User Manual C-63



Appendix C: Remote Commands

SyncTimesVal[1..7]?
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Syntax

Group

Arguments

Related Commands

Returns

Examples

Query the specified synchronization time (in nanoseconds) resulting from Sync

measurement.

VARIable:VALue? "SyncTimesVal[l..7]"

Results

None

SyncTimes

Returns specified synchronization time (in nanoseconds).

Values must be in these ranges:
For Tri-Level 1..7
For Bi-Level 1..5

Values must designate the following times:

For Tri-Level: 1-FrontPorch, 2-NegativeSyncFall, 3-NegativeSyncWidth,
4-SyncRise, 5-PositiveSyncWidth, 6-PositiveSyncFall, 7-BackPorch.

For Bi-Level:  1-FrontPorch, 2-NegativeSyncFall, 3-NegativeSyncWidth,
4-SyncRise, 5-BackPorch.

Returns "---" if no valid measurement currently available.

VARIable:VALue? "SyncTimesVal2"

Query may return: "SyncTimesVal2 59.03"
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Trigger < trigger >

Syntax

Group

Arguments

Returns

Examples

Set or query video trigger to use for measurement.

VARIable:VALue "Trigger", "< trigger >"
VARIable:VALue? "Trigger"

Configuration

< trigger > specifies trigger that is to be used.
Valid triggers are: Chl, Ch4.

Query returns the current specitied trigger.

VARIable:VALue "Trigger", "Ch4"
VARIable:VALue? "Trigger"

Query may return: "Trigger Ch4"
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WarningReportingMeasure < setting >

Syntax

Group

Arguments

Related Commands

Returns

Examples

C-66

Set or query whether the instrument displays a measurement setup problem
warning dialog on the instrument screen.

VARIable:VALue "WarningReportingMeasure", "< setting >"
VARIable:VALue? "WarningReportingMeasure"

Configuration

< setting > Valid settings are: OFF, ON, 0, 1.
OFF is the same as 0, and ON is the same as 1.

WarningReportResults
WarningReportSignal

Query returns the current specified setting.

VARIable:VALue "WarningReportingMeasure", "ON"
VARIable:VALue? "WarningReportingMeasure"

Query may return: "WarningReportingMeasure 0"
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WarningReportingResults < setting >

Syntax

Group

Arguments

Related Commands

Returns

Examples

Set or query whether the instrument displays a measurement results warning
dialog on the instrument screen.

VARIable:VALue "WarningReportingResults", "< setting >"
VARIable:VALue? "WarningReportingResults"

Configuration

< setting > valid settings are: OFF, 0, ON, 1.
OFF is the same as 0, and ON is the same as 1.

WarningReportingMeasure
WarningReportingSignal

Query returns the current specified setting.

VARIable:VALue "WarningReportingResults", "ON"
VARIable:VALue? "WarningReportingResults"

Query may return: "WarningReportingResults 0"
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WarningReportingSignal < setting >

Syntax

Group

Arguments

Related Commands

Returns

Examples
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Set or query whether the instrument displays an input signal problem warning
dialog on the instrument screen.

VARIable:VALue "WarningReportingSignal", "< setting >"
VARIable:VALue? "WarningReportingSignal"

Configuration

< setting > valid settings are: OFF, 0, ON, 1.
OFF is the same as 0, and ON is the same as 1.

WarningReportingMeasure
WarningReportingResults

Query returns the current specified setting.

VARIable:VALue "WarningReportingSignal", "ON"
VARIable:VALue? "WarningReportingSignal"

Query may return: "WarningReportingSignal 0"

VMS5000 Option HD Automatic Video Measurement Set User Manual



Appendix C: Remote Commands

Warning < setting >

Syntax

Group

Arguments

Returns

Examples

Command can be used to reset Warning to “0”. Query returns the most recent
warning reported by the application, or “0” if no warning have occurred since
Warning was last reset. All warnings (Measurement, Signal, and Results) will be
reported.

Initialized to “0” on startup.

VARIable:VALue "Warning" < setting >
VARIable:VALue? "Warning"

Miscellaneous

< setting > resets Warning to 0.
Valid values are: OFF, 0.

Returns the most recent warning reported by the application. Returns “0” if no
warning has occurred since the Warning command was last reset. For a listing of
all possible warnings, refer to Table C-8 on page C-70.

VARIable:VALue "Warning", "OFF"
VARIable:VALue? "Warning"

Query may return:
"Warning Color Bars: Back Porch Reference Questionable"
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Warning and Error Messages

Tables C-8 and C-9 list the warning and error messages you could see.

Table C-8: Warning messages
Number | Text Possible causes Operation where it may occur
1 Acquisition Problem The instrument cannot trigger or the signal | All measurements
levels are out of range.
2 Channel Delay: Channel <x> & <y>, You may have the wrong line in the matrix | Measuring Channel Delay
Correlation Too Low signal, a distorted signal, or an inappropri-
ate input signal with too few transitions.
3 Channel Delay: Disjoint Correlations There is a possible group delay mismatch | Measuring Channel Delay
Among Channels... among channels, or there is an inappropri-
ate signal source.
4 Color Bars: <Color> Bar Not Found You may have the wrong line in the matrix | Measuring Color Bars
signal, a distorted signal, an incorrect
format selected, channels connected in the
wrong order, the wrong colorimetry, or
excessive cropping of the signal.
5 Color Bars: Back Porch Reference The signal is distorted. Measuring Color Bars
Questionable
6 Multiburst: Signal Change: <freq1> -> You may have low signal levels, an Measuring Multiburst
<freq2> MHz incorrect signal, or a change in the signal.
7 Multiburst: Individual Channel Errors: The signal is distorted or a flag is missing | Measuring Multiburst
Channel <x>: Flag <= 0 mV in the signal.
8 Multiburst: Individual Channel Errors: You may have low signal levels, distorted | Measuring Multiburst
Channel <x>: burst <n>: not detected signals, an input signal with less than six
frequency packets, or excessive cropping
of the signal.
9 Multiburst: Invalid results for all channels | You may have the wrong line in the matrix | Measuring Multiburst
signal, an inappropriate input signal, or an
incorrect configuration.
10 Noise: Signal Change: Chan <x> The signal changed during measurement. | Measuring Noise
1 Noise: Invalid results for all channels. You may have the wrong line in the matrix | Measuring Noise
signal, an inappropriate input signal, or an
incorrect configuration.
12 Nonlinearity: Invalid Results: Channel <x>: | You may have the wrong line in the matrix | Measuring NonLinearity
No ramp or step signal found signal or an inappropriate input signal.
13 Nonlinearity: Signal Change: Channel <x>: | The signal changed during measurement. | Measuring NonLinearity
14 Sync Measurements Inconclusive The instrument could not find a proper Measuring Sync
sync, the wrong format was selected, or
the signal is distorted.
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Table C- 8: Warning messages (Cont.)

Number | Text Possible causes Operation where it may occur
15 Sync Measurement: <n> Not Found The instrument could not find a proper Measuring Sync

sync.
16 Writing over file <filename> The instrument is writing over a file that Recalling settings;

previously existed.

Generating a report

Table C-9: Error messages

Number | Text Possible causes Operation where it may occur
1 File Name Error: File doesn’t exist: The selected .vmset file doesn't exist. (You | Recalling settings
<filename> need to use the full path if the file is not in
the directory C:\VM5000HD.)
2 Cannot write directory: file already exists: | You need to rename <filename> so that Saving settings;
<filename> the directory can be written. Generating a report
3 File Name Error. Invalid character(s) in file | There are invalid characters in the Saving settings;
name filename. (Refer to the command structure | Generating a report
description on page C-1.)
4 No Measurement Selected No measurements are selected in the Executing a measure;
Configuration > Measurements menu. Generating a report
5 Cannot create Report. Not all selected Need to run a measurement and wait until | Generating a report
measures have been Run it completes before generating a report.
6 Invalid Filename An invalid or non-existing file was used RecallSettings;
when performing the operation. Refer to SaveSettings;
the command structure description on ReportGenerate (only when
page C-1. Also, you need to use the full called via GPIB)
path if the file is not in the directory
C:\VM5000HD.
7 Invalid Argument An inappropriate argument was used for All GPIB commands
the particular GPIB command.
8 Command Overflow The GPIB commands were sent in too Any time GPIB commands are
rapidly to the instrument. Increase the sent in too rapidly
delay time between commands to prevent
this problem (recommended 100 millisec-
onds), or use handshaking with OPCom-
plete.
9 Command Missed Under certain configurations, a command | Sending a GPIB command

can occasionally fail to be processed by
the instrument. This error suggests that a
command sent in the last second may not
have been processed, so you should
return to a recent (known) configuration
and re-send the most recent commands.
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Appendix D: Cleaning

Exterior Cleaning

Use these procedures to clean your instrument. If additional cleaning is required,
have your instrument serviced by qualified service personnel.

Clean the exterior surfaces of the chassis with a dry lint-free cloth or a soft-
bristle brush. If any dirt remains, use a cloth or swab dipped in a 75% isopropyl
alcohol solution. Use a swab to clean narrow spaces around controls and
connectors. Do not use abrasive compounds on any part of the chassis.

Clean the On/Standby switch using a dampened cleaning towel. Do not spray or
wet the switch directly.

CAUTION. Do not use chemical cleaning agents that might damage the plastics
used in this instrument. Use only deionized water when cleaning the

front-panel buttons. Use a 75% isopropyl alcohol solution as a cleaner and rinse
with deionized water. Before using any other type of cleaner, consult your
Tektronix Service Center or representative.

To prevent getting moisture inside the instrument during external cleaning, use
only enough liquid to dampen the cloth or applicator.

Flat Panel Display Cleaning

/N

The display is soft plastic and must be treated with care during cleaning.

CAUTION. Improper cleaning agents or methods can damage the flat panel
display.

Do not use abrasive cleaners or commercial glass cleaners to clean the display
surface.

Do not spray liquids directly on the display surface.

Do not scrub the display with excessive force.
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Clean the flat panel display surface by gently rubbing the display with a
clean-room wipe (such as Wypall Medium Duty Wipes, #05701, available from
Kimberly-Clark Corporation).

CAUTION. To prevent getting moisture inside the instrument during external
! cleaning, use only enough liquid to dampen the cloth or applicator.

If the display is very dirty, moisten the wipe with distilled water or a 75%
isopropyl alcohol solution and gently rub the display surface. Avoid using excess
force or you may damage the plastic display surface.
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Appendix E: Rebuilding the Hard Drive

If you need to rebuild the hard drive, you must install software from three CDs
in the following order:

1. Follow the directions in the CD jewel-case booklet to install the Operating
System Restore CD, 063-3693-XX.

2. Follow the directions in the CD jewel-case booklet to install the TDS5000B
Product Software CD, 063-3692-XX.

3. Install the VM5000 Option HD application CD, 063-3768-XX.
4. Follow the online instructions.

When asked, enter your option key information from the sticker on the back
of your instrument.
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Appendix F: Signal Source Disks

The Signal Source Disks consists of four CDs and two DVDs that ship with the
VMS5000 Option HD as a standard accessory. These disks contain Matrix test
pattern signal source files in a number of video formats. See page 2-6 for
information on the Matrix test pattern. Table F-1 lists the signal source disks.

Table F-1: Signal Source Disks

Title Tektronix part number
Baseband Test Signals 063-3660-XX
ATSC Transport Streams 063-3661-XX
Advanced TV Elementary Streams 063-3662-XX
Standard Definition TV Elementary Streams | 063-3663-XX
480 Line DVD 063-3664-XX
576 Line DVD 063-3665-XX

Baseband Test Signals CD

The Baseband Test Signals disk (Tektronix part number 063-3660-XX) contains
files for generating baseband test signals. There are two directories:

®m  The PC directory contains an SXGA sub-directory that contains a 1280 X
1024 bitmap image file, which you can open with MS Paint on a PC and
display the Matrix test pattern at 1280 x 1024 resolution at a 60 Hz
horizontal refresh rate. See page 1-15 for instructions on how to use the
SXGA Matrix bitmap file.

®  The TG700 directory contains setup (.dnl) files for generating Matrix test
signals using the Tektronix TG700 TV Signal Generator Platform. Table F-2
lists the available image format standard .dnl setup files.

Table F-2: Available TG700 DNL signal format files

Image format Field rate TG700 module Color space Signal file name

480p (525 total lines) 59.94 AVG7 RGB 525PSGBR.DNL
YPyP, S525PY.DNL

576p (625 total lines) 50 AVG7 RGB 625PSGBR.DNL
YPyP, S625PY.DNL
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Table F-2: Available TG700 DNL signal format files (Cont.)

Image format Field rate TG700 module Color space Signal file name
720p 59.94 AWVG7 RGB 72059PG.DNL
YPyP; 72059PY.DNL
1080i 50 AWVG7 RGB 1080501G.DNL
YPyP; 1080501Y.DNL
1080i 59.94 AWVG7 RGB 108059TG.DNL
YPyP; 1080591Y.DNL

To use the TG700 .dnl setup files, copy the required file or files to a PC. Then
use the communication program that came with the TG700 to move the setup
files over your network from the PC to the TG700 instrument. Figure F-1 shows
a typical test signal setup using the TG700 instrument as the signal source.

MPEG
\P( PEG tratnspon o \FC CH1
b stream X
TG700 DNL——>] TG700 =" Gompression Modulator DUT | oH2 - VMs000
baseband files ! ' fcHg Option HD

Figure F-1: Using TG700 baseband test signals
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ATSC Transport Stream CD

The ATSC Transport Streams disk (Tektronix part number 063-3661-XX)
contains files for playout on an MPEG player (such as the Tektronix MTX100
MPEG Recorder and Player) to generate Matrix pattern compressed ATSC
transport stream test signals for 480, 720, and 1080 standards. Table F-3 lists the
available image format standard .trp setup files.

Table F-3: Available MXT100 .trp signal setup files

Image Associated VM5000 Option

format Field rate MTX100 setup file(s) HD setup file

480p 59.94 Tek480pMatrix.trp Tek480pMatrix.vmset
Tek480p16x9Matrix.trp

720p 59.94 Tek720pMatrix.trp Tek720pMatrix.vmset

1080i 59.94 Tek1080iMatrix.trp Tek1080iMatrix.vmset

The disk also contains some or all of the following:

®  Readme files that contain detailed information on each signal setup file. You
should view the readme files before using a signal setup file.

®m  The .vmset files that you recall into the VM5000 Option HD instrument to
configure the correct default line number values for each measurement. See
page 2-16 for instructions on how to recall VM5000 Option HD instruments
setups.

NOTE. You must use the associated .vmset file to configure the VM5000 Option
HD before taking measurements from test signals generated using a .trp setup
file.

B WFM700 directories that contain .bmp-format screen captures from the
Tektronix WFM700 series Waveform Monitor, showing individual lines and
channels of the Matrix test signal 1 minute video loop, for a particular
format.
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To use the MTX100 .trp setup files, insert the disk into the MTXO00. Refer to the
MTX100 MPEG Recorder and Player User manual for information on loading
instrument setup files. Figure F-2 shows a typical test signal setup using the
MTX100 instrument as the signal source.

MPEG
transport RE \P( CH1

Transport Stream files on CD——»| MTX100 |—S1eam | Modulator DUT blcH2  VMS5000

Pr CH3 OptiOH HD

Figure F-2: Using ATSC transport stream signals
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Advanced TV Elementary Streams CD

Standard Definition TV Elementary Streams CD

The Advanced TV Elementary Streams disk (Tektronix part number
063-3662-XX) and the The Standard Definition TV Elementary Streams disk
(Tektronix part number 063-3663-XX) contain MPEG2-compressed elementary
stream files. You use these files with a transport stream multiplexor to build
advanced TV or standard definition TV transport streams. Tables F-4 and F-5
list the available elementary stream formats.

Table F-4: Available Advanced TV Elementary Streams

Image Associated VM5000
format Field rate | File Ratio Option HD setup file
480p 59.94 Tek480pMatrix.mpg 4:3 Tek480pMatrix.vmset
Tek480p16x9Matrix.mpg | 16:9
720p 59.94 Tek720pMatrix.mpg Tek720pMatrix.vmset
1080i 50 Tek1080i50Matrix.mpg Tek1080iMatrix.vmset
59.94 Tek1080iMatrix.mpg

Table F-5: Available Standard Definition TV Elementary Streams

Image Associated VM5000

format Field rate | File Ratio Option HD setup file

480i 59.94 Tek480iMatrix.mpg 4:3 none
Tek480i16x9Matrix.mpg | 16:9

576i 59.94 Tek576iMatrix.mpg 4:3 none
Tek576i16x9Matrix.mpg | 16:9
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Elementary Stream —

files on CD

The disk also contains some or all of the following:

B Readme files that contain detailed information on each signal setup file. You
should view the readme files before using a signal setup file.

®m  The .vmset files that you recall into the VM5000 Option HD instrument to
configure the correct default line number values for each measurement. See
page 2-16 for instructions on how to recall VM5000 Option HD instruments
setups.

NOTE. You must use the associated .vmset file that is on the same disk to
configure the VM5000 Option HD before taking measurements that use the
elementary stream signals.

To use the elementary stream files, copy the appropriate files into your transport
stream multiplexor. Figure F-3 shows a typical elementary stream test setup.

Transport
Stream
Multiplexor

MPEG

transport RE \P( CH1

stream Modulator DUT Pb CH2  VM5000
* {cyg  Option HD

Figure F-3: Using elementary stream signals
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480 & 576 Line DVDs

The 480 Line DVD (Tektronix part number 063-3664-XX) and 576 Line DVD
(Tektronix part number 063-3665-XX), both generate 60-second Matrix pattern
test signals for use with the VM5000 Option HD instrument. The DVD files are
available in the formats listed in Table F-6.

Table F-6: Available formats of DVD files

DVD Image format Field rate Program/Track | Ratio

480 Line 480i 59.94 1 16:9
2 4:3

576 Line 576i 50 1 16:9
2 4:3

To use the DVD, insert the appropriate DVD into the player, then select the
appropriate program/track for the ratio. Figure F-4 shows the typical setup for
testing DVD players.

o : CH1
FiesonDVD —  piaer Pb CH2  VMS5000
r CH3 OptiOH HD

Figure F-4: Using DVD signals

NOTE. The DVD files are in interlace format. The playback device must be set to
progressive mode (480p or 576p) before sending signals to the VM5000 Option
HD instrument.
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Index

Numbers

3-wire composite sync setup, 2-2, 2-3
4-wire with separate sync setup, 2-4
75 Ohm termination, CH4, 2-4

A

Access the Windows desktop, 2-8
Accessories, 1-19
connecting peripherals, 1-7
optional, 1-21
probes, 1-3-1-4
standard, 1-20
Address, Tektronix, xi
Adjusting display contrast, 1-12
Algorhythm descriptions. See Measurements, detailed
information
All button, 2-18, 3-11
Ambient temperature, A-1
Amplitude change, re-do auto scaling, 3-7
App button, 2-8
Application display, default, 2-7
Application software version number, 3-12
Application view area, 2-8
Applications, Microsoft, 1-11
Auto Scale
buttons, 2-12
re-do, 3-7
AutoScale, C-8
Averages, 3-13
interactions with results, 3-8
interactions with Run Mode, 3-8

Backing up user files, 1-9
Baseband files, Matrix test pattern, F-1
Buttons
All, 2-18, 3-11
App (restore hidden application), 2-8
Auto Scale On/Off, 2-12
color space type, 2-9
Continuously, 2-12, 3-7
CSy, 2-17, 3-11
Exit, 2-8
Generate Report, 2-18
Hide, 2-8
input signal format, 2-9

instrument On/Standby, 2-7

Once, 2-12, 3-7

Open (load measurement settings), 2-16
PDF, 2-17, 3-11

RTF, 2-17, 3-11

Run, 2-8

Run Mode, 2-12, 3-7

Run Only, 2-11, 3-6

Save (measurement settings), 2-15
Selected, 2-18, 3-11

Setup & Run, 2-11, 3-6

Setup Only, 2-11, 3-6

Stop, 2-8

sync signal trigger channel select, 2-12

C

CD-ROMs, product software, 1-10
Certifications and compliances, A-16
Changing measurement settings, 2-14
Channel Delay measurement, detailed information,
3-14

Channel input and vertical specifications, A-2
ChannelDelayAll?, C-9
ChannelDelayAverage, C-10
ChannelDelayCh1Ch2?, C-11
ChannelDelayCh1Ch3?, C-12
ChannelDelayCh2Ch3?, C-13
ChannelDelayLine, C-14
ChannelDelaySet, C-15
Cleaning

exterior, D-1

flat panel display, D-1
Color Bars measurement, detailed information, 3-16
ColorBarsAverage, C-16
ColorBarsLine, C-17
ColorBarsmVCh[1..3], C-18
ColorBarsmVCh[1..3]Val[1..8], C-19
ColorBarsSet, C-20
ColorSpace, C-21
Commands, C-8

See also Remote commands
Compressed elementary stream files, F-5
Compressed transport stream files, F-3
Configuration commands, C-4
Configuration menu, 3-5
Connecting input signals, 2-2
Connecting peripherals, 1-7
Connecting to a network, 1-11
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Contacting Tektronix, xi
Creating an emergency startup disk, 1-9
CSy, 2-17, 3-11

D

Data storage specifications, A-13
Default application display, 2-7
DefaultSettings, C-22
Description

key features, 1-1

product, 1-1
Desktop, accessing windows, 2-8
Display specifications, A-11
DNL files, Matrix test pattern, F-1
Documentation, related, x
DVD files, Matrix test pattern, F-7
Dynamic range, maximize by autoscaling, 3-7

E

Elementary stream files, Matrix test pattern, F-5
Environment requirements, 1-6

Environmental specifications, A-15

Error, C-23

Error and warning messages, C-70

Execute, C-24

Exit button, 2-8

Exiting the application, 1-11

Exterior cleaning, D-1

F

File menu, 3-3
Files
.vmset, 3-3
Matrix test pattern signal source, F-1
reports, 3-11
Filter settings, 3-8
Firmware, upgrade, 1-3
Flat panel display cleaning, D-1
Format, C-25
Format, input signal, 2-9
Function reference, 3-3

G

Generate Report menu, 3-11

GPIB commands. See Remote commands

GPIB operation, avoiding message box interruptions,
3-7

H

Help, 3-12
Hide button, 2-8
Horizontal and acquisition system specifications, A-7

ID?, C-26
Input Matrix test pattern files
for a DVD player, F-7
for MTX100, F-3
for TG700, F-1
for transport stream multiplexor, F-5
Input signal. See Matrix test pattern; Measurements,
detailed information
Input signal connection requirements, 2-1
Input signal format, 2-9
Input signal format view, 2-9
Input signal setups
3-wire composite sync, 2-2, 2-3
4-wire with separate sync, 2-4
PC video card, 2-5
Input/output port specifications, A-12
Installation, 1-5
incoming inspection procedure, 1-13
software installation, 1-10
Installing system software, E-1
Interruptions by message boxes, avoiding, 3-7
Intrepreting results. See Measurements, detailed
information
Introduction, to this manual, ix

K

Key features, 1-1

L

LCD display contrast, 1-12

Line Number, 3-8

Line Number defaults in .vmset file, 3-3
Loading saved measurement setups, 2-16

Manuals
part numbers, 1-20
related, x
Matrix signal line numbers, 3-13
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Matrix test pattern

formats, F-1

picture, 2-6
Matrix test signal, matching setup file, 3-3
Measurement settings, changing, 2-14
Measurement setups

recalling, 2-16

saving, 2-15
Measurement steps overview, 2-9
Measurements

detailed information, 3-13

measurements to report, 2-18, 3-11

overview, 3-8

report formats, 2-17, 3-11

reports, 2-17

saving results (reports) to a file, 2-17

selecting, 2-10

setting run-time options, 2-11
Mechanical specifications, A-14
Menu bar, 2-8
Menu descriptions, 3-3
Message boxes, avoiding interruptions, 3-7
Messages, C-70
Minimizing the application and main display, 2-8
Miscellaneous commands, C-4
MTX100 files, Matrix test pattern, F-3
Multiburst measurement, detailed information, 3-17
MultiburstAmpdBCh[1..3], C-27
MultiburstAmpdBCh[1..3]Val[1..6], C-28
MultiburstAverage, C-29
MultiburstFlagmVCh[1..3], C-30
MultiburstFreqCh[1..3], C-31
MultiburstFreqCh[1..3]Val[1..6], C-32
MultiburstLine, C-33
MultiburstSet, C-34
Multiplexor files, Matrix test pattern, F-5

Network access, 1-11

Noise measurement, detailed information, 3-19
NoiseAmpdBCh[1..3], C-35
NoiseAmpmVCh[1..3], C-36

NoiseAverage, C-37

NoiseBW, C-38

NoiseFilter, C-39

NoiseLine, C-40

NoiseSet, C-41

Non Linearity measurement, detailed information, 3-20

NonLinearityAverage, C-42
NonLinearityLine, C-43
NonLinearityPctCh[1..3], C-44

VMS5000 Option HD Automatic Video Measurement Set User Manual

NonLinearityPctCh[1..3]Max?, C-45
NonLinearityPctCh[1..3]Val[1..5]?, C-46
NonLinearitySet, C-47

0]

On/Standby switch, 1-8

Online help, 3-12

OPComplete, C-48

Open (load measurement settings) button, 2-16

Opening, .vmset files, 3-3

Operating requirements, 1-6

Optimizing for production line testing, auto scale Off,
3-7

Option SS, F-1

Optional accessories, 1-21

Options, 1-19

Out of range, preventing by autoscaling, 3-7

P

PC video card test setup, 2-5
PDF, 2-17, 3-11
Performance verification
functional tests, 1-14
self tests, 1-13
Peripherals, connecting, 1-7
Phone number, Tektronix, xi
Power source specifications, A-14
Powering off, 1-8
Powering on, 1-8
Probes, supported, 1-3
Product
accessories. See Accessories
description, 1-1
models, 1-1
unpacking, 1-5
Product features, 1-1
Product support, contact information, xi

Q

Quitting the application, 1-11

R

Re-do auto scaling, 3-7

Rebuilding the Hard Drive, E-1
Recalling measurement setups, 2-16, 3-3
RecallSettings, C-50
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Reinstalling the system software, E-1 Specifications, A-1
Related documentation, x certifications and compliances, A-16
Release notes, 1-10 channel input and vertical, A-2
Remote commands, C-1 data storage , A-13
command descriptions, C-8 display, A-11
startup and exit, C-3 environmental, A-15
Report generating, menu descriptions, 3-11 horizontal and acquisition system, A-7
ReportGenerate, C-51 input/output port , A-12
Reports, viewing on the MS Windows desktop, 2-8 mechanical, A-14
Reports commands, C-5 power source, A-14
ReportString, C-52, C-53 trigger, A-8
Restore the application when hidden, 2-8 video measurements, A-1
Results appear as dashes, 3-5 Standard accessories, 1-20
Results commands, C-5 Starting the application, 2-7
Results menu, 3-8 Startup disk, creating, 1-9
RTF, 2-17, 3-11 Stop button, 2-8
Run button, 2-8 SXGA/60 bitmapped file, Matrix test pattern, F-1
Run commands, C-6 Sync measurement, detailed information, 3-21
Run Mode, 3-6 Sync signal trigger channel buttons, 2-12
buttons, 2-12 SyncAverage, C-58
interactions with Average setting, 3-8 SyncLevelsmV?, C-59
Run Only button, 2-11, 3-6 SyncLevelsmVVal[1..3]?, C-60
RunMode, C-55 SyncLine, C-61
Running the application, 2-7 SyncSet, C-62

SyncTimes?, C-63
SyncTimesVal[1..7]?, C-64
S Syntax, C-1

SaveSettings, C-56 System diagnostics menu, 1-13

Saving measurement setups, 2-15

Selected button, generating reports, 2-18, 3-11 T

Selecting measurements, 2-10

Serial, command descriptions, C-8 Taking a measurement, 2-13

Service support, contact information, xi Taking measurements overview, 2-9
Setting run-time options, 2-11 Technical support, contact information, xi
Settings commands, C-6 Tektronix, contacting, xi

Setup & Run button, 2-11, 3-6 Termination, 75 Ohm, CH4, 2-4

Setup commands, C-6 Test signal. See Matrix test pattern

Setup for functional tests, 2-5 TG700 DNL files, Matrix test pattern, F-1
Setup Only button, 2-11, 3-6 Transport stream files, Matrix test pattern, F-3
SetupAndOrRun, C-57 Trigger, C-65

Show the application when hidden, 2-8 Trigger specifications, A-8

Shutdown, 1-8

Signal amplitude change, auto scaling, 3-7

Signal path compensation, 1-14, A-1 U

Signal sources
matrix files, F-1
non-matrix. See Measurements, detailed information
Site considerations, 1-6
Software, reinstallation, E-1
Software installation, 1-10
Software version number, 3-12
Space requirements, 1-6

Unhiding hidden application, 2-8
Upgrade, firmware, 1-3

URL, Tektronix, xi

USB devices, 1-7

User files, backing up, 1-9

User interface description, 2-8
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Utilities menu
Generate Report, 3-11
Instrument Calibration, 1-14
Instrument Diagnostics, 1-13

vV

Verification, incoming inspection procedure, 1-13
Version number, 3-12

Vertical scale autoscaling, 3-7

Video specifications, A-1

Viewing measurement results, 2-13

Viewing reports on the desktop, 2-8

VMSET files, recalling, 3-3

w

Warning, C-69

Warning and error messages, C-70

Warning message boxes, turn off or on, 3-7
Warning message reporting, 2-12
WarningReportingMeasure, C-66
WarningReportingResults, C-67
WarningReportingSignal, C-68

Web site address, Tektronix, xi

Windows desktop, accessing, 2-8

Windows operating system, backup tool, 1-9
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